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Adding axes grids to graphs
1. Select the graph window.

If your graph is not in a graph window, double-click the graph.

2. Choose Graph Elements from the Format menu.

3. Select Display X Grid to add vertical grid lines to the graph.

4. Select Display Y Grid to add horizontal grid lines to the graph.

5. Choose OK.



 Adding borders
1. Select the range to format.

2. Choose Format from the Range menu.

3. Choose Borders from the Format menu.

4. Select the desired border options and choose OK.

Shortcuts

CTRL+B
Cell right-click menu
Related Topics
Border command (Format menu)



Adding graph titles
1. Select the graph window.

If your graph is not in a graph window, double-click the graph.

2. Choose Set Titles from the Format menu.

3. Type in the titles for Graph, X Axis, and Y Axis.

4. Choose OK.



Adding headers and footers
1. Choose Page Setup from the File menu.

2. Choose the Header or Footer button

3. In the text box enter any text or special codes you want to appear in the header or footer. See the
Header and footer codes topic for information on header and footer codes. 

4. If you want to set up a different font, select the Font button.

5. Choose the Ok button to close the header or footer dialog box.

6. Choose the Ok button to close the Page Setup dialog box.



Adding shadow to floating objects
1. Select the floating object.

2. Click the right mouse button.
The floating object right-click menu appears.

3. Choose Shadow from the floating object right-click menu.
The Shadow option is selected when the Shadow command is preceded by a check mark.



Adding text to floating objects
1. Select the floating object.

2. Type in the text for the floating object.

If the text you type is not shown, the Text option may not be selected. To select the text option,

1. Select the floating object.

2. Click the right mouse button.
The floating object right-click menu is displayed.

3. Choose Text from the floating object right-click menu.



Adjusting column widths
· Drag the line to the right or left of the column to the desired width.

-or-

1. Select the column by selecting any cell in the column.

2. Choose Range|Size.

3. Select Width.

4. Select the appropriate sizing option.

5. Type in the desired width.

6. Choose the OK button.

Related Topics
Adjusting row heights

Size command (Range menu)



Adjusting row heights
· Drag the line to the right or left of the column to the desired width.

-or-

1. Select the row by selecting any cell in the row.

2. Choose Range|Size.

3. Select Height.

4. Select the appropriate sizing option.

5. Type in the desired width.

6. Choose the OK button.

Related Topics
Adjusting column widths

Size command (Range menu)



Aligning text and numbers
1. Select the cells to align.

2. Choose Range|Format|Alignment.

3. Select the desired alignment options.

4. Choose the Ok button.

Shortcuts

    (to set horizontal and vertical alignment)

    (to set left alignment)

    (to set center alignment)

    (to set right alignment)
Cell right-click menu
CTRL+A
Related Topics
Alignment command (Format menu)
Cell right-click menu



Assigning macros to push buttons
1. Select the push button.

2. Click the right mouse button.

3. Choose Assign Macro.

4. Select the macro from the Macro List.

5. Choose the OK button.

Shortcuts
Push Button right-click menu

Related Topics
Creating a push button

Recording a macro



Auditing spreadsheets
Auditing is analyzing a spreadsheet for accuracy and elimination of errors. The easiest errors to detect 
and correct are obvious errors, such as a misspelling or incorrect formula or data. These types of errors 
usually show ERR or an implausible result and are easy to find.

Less obvious errors can be a real menace. Sometimes, in creating a model, you will copy and paste, 
insert or delete rows or columns, or make other changes. The original formulas no longer reflect the right 
locations in the sheet. Audit lets you analyze the relationships between cells in the current sheet, as well 
as the relationships between different sheets linked with File Links.

An Audit is a systematic examination to insure the accuracy of your spreadsheet. The selections on Lucid 
3-D's Audit dialog box aid in such a systematic examination.    However, the process of verification can be 
enhanced or hindered by how you build your spreadsheet.

Avoiding Bugs
You can make your spreadsheets easier to understand, therefore easier to verify, by keeping them cleanly
laid out, and by making the formulas easy to understand.

1. Use named cells and ranges when writing formulas. For example a formula that reads:
SUM(Monthly Sales)-SUM(Monthly Expenses)
is more comprehensible than its equivalent, without named ranges:
SUM(D8:O8)-SUM(D12:O12)

2. Annotate your formulas. If you are writing a formula of some complexity, use F3 (Note) to put an 
explanation in that cell. It helps other people who review your spreadsheet and it helps you 
remember what you were trying to do and why the formula works. 

3. Modularize complicated problems. This is where Lucid 3-D really shines. Rather than attempting 
to put enormous, complicated webs of relationships and data into one big spreadsheet, break it 
up into its logical components. Organize the problem into layers or referenced spreadsheets, with
summary spreadsheets. Keep summary spreadsheets to a single screen. 

4. Lay out your spreadsheet in a way that is pleasing to the eye, so that logical relationships 
between values are reflected in their physical layout on the screen. .

5. If you don't have all the data you need at the time you are constructing the spreadsheet, use the 
NA( ) function in place of the missing numbers. All results that depend on data that is not yet 
available will display NA. If you leave such cells blank, you may omit an important number later.

The Audit Dialog Box
While it is preferable to avoid entering bugs in the first place, Lucid 3-D does provide a means of    finding 
bugs in your spreadsheet. Audit displays a list of various characteristics of the current spreadsheet or a 
specific cell. You can select which characteristic Lucid 3-D displays. To display the Audit dialog box, 
choose Audit from the Tools menu.

Choose one of the following characteristics to display.

· Notes are annotations to a cell you create by pressing F3 or selecting Edit Notes. Select this 
characteristic to see a list of notes contained in the spreadsheet. To display notes in the 
spreadsheet itself, use Tools|Sheet Preferences.

· Unreferenced lists cells containing values (numbers) not used by any formula. Lucid 3-D omits 
cells that appear in formulas as cell references, or as part of a range    that a function uses.    A 
number that you add to the end of a column might be omitted from the total at the bottom. Listing 
unreferenced cells points out the mistake instantly.

· Formulas lists cells in the spreadsheet that contain formulas. You can view them all at once and 
inspect relationships easily. To display formulas in the spreadsheet itself, use Tools|Sheet 



Preferences.

· File Links lists all occurrences of the REF function in the current spreadsheet. A REF function 
references another spreadsheet file for its data. 

· Dependents lists all cells whose values are dependent on the value in a specific cell. It helps you
find all the places you use a certain value and helps you decide the best way to change it if 
necessary.

· Sources lists all cells on which the current cell depends. It is particularly helpful when you have 
named many of the cells and ranges in the spreadsheet. Sources allows you to easily see if this 
cell depends on a piece of unrelated data.

Unless you specify a particular cell, Audit displays characteristics for the entire spreadsheet. Dependents
and Sources list information for a single cell only. If you do not specify a cell, they examine the cell under 
the widebar.

Audit lists the information in a pop-up window. Remove the list by pressing ESC or ENTER. 



Changing colors and patterns in a graph
1. Select the graph window.

If your graph is not in a graph window, double-click the graph.

2. Position the mouse pointer over the series to modify.

3. Click the right mouse button.

4. Select the color from the Series Color list.

5. Select the style from the Series Style list.



Changing graph fonts
1. Select the graph window.

If your graph is not in a graph window, double-click the graph.

2. Choose Font from the Format menu.

3. Select the fonts from the list boxes provided.



Changing graph types
1. Select the graph window.

If your graph is not in a graph window, double-click the graph.

2. Choose the graph type from the Styles menu.



Changing the layout of a printed page
1. Choose Page Setup from the File menu.

2. Under Margins, choose the top, right, bottom and left margins for the page.

3. Under Paper Size, choose the size of the paper.

4. Under Orientation, select Portrait to print the page horizontally or select Landscape to print the 
page vertically.

5. To change headers or footers, choose the Header or Footer button.

6. Select any other attributes you want.

7. To preview the printed page, choose the Print Preview button.

8. To change printer settings, choose the Printer button.

9. To print the document, choose the Print button.



Choosing a command
To choose a menu option using the keyboard

1. Press ALT to select the menu bar.

2. Press the underlined character to select the menu.

3. Use the arrows keys to highlight the command.

4. Press ENTER.

To choose a menu option using the mouse
1. Click the menu name containing the command.

2. Click the command.

To choose an option in a dialog box using the keyboard
· Press ALT and the underlined character of option.

To choose an option in a dialog using the mouse
· Click the option.

To perform the command after making your selections
· Click on OK or press ENTER.

· If you wish to cancel the command without making changes, click on Cancel or press ESC



Closing the active window
1. Choose File|Close.

If no changes to the spreadsheet have been made since the last save, Lucid 3-D will exit 
immediately.

· Choose the Yes button to save changes.
If this is the first time you have saved the spreadsheet, Lucid 3-D will present the Save As dialog 
box. Type in a file name for the file and choose the Ok button.

· Choose the No button to discard the changes.
Lucid 3-D will not write the changes to disk.

· Choose the Cancel button to cancel closing the window.
Lucid 3-D will cancel the command and the window will remain open.



Connecting to a palmtop, handheld, or PDA computer
Installing Connectivity Packs
You must install connectivity packs on your computer before you can take advantage of their file transfer 
capabilities. 

1. Choose Connect from the File menu.

2. Click Add to add a new connectivity pack to the list. 

3. Select the filename of the connectivity pack. If you are installing the Casio Connectivity Pack, 
select CPCASIO.LCP. Click OK or press ENTER. 

4. Select the communication Port.    You can select from COM1, COM2, COM3, or COM4. If you are
unsure which port to select, check the documentation for your computer or the configuration 
settings on the appropriate hardware device. 

5. Select the Baud rate. It can be set at 1200, 2400, 4800 or 9600. The default setting is 9600. Baud
rates must be identical on both computers. 

6. For Parity, choose from None, Odd or Even. None is the default. The setting for both computers 
must be identical. 

7. Select a Bit Length of 7 or 8 bits. Lucid 3-D reverts to 8 bits regardless since spreadsheet files 
contain binary data.    Bit length must also be identical on both machines. 

8. Choose a Machine Type. For the Casio Connectivity Pack the choices are SF Unit or ES-630. 
These options differ with other connectivity packs.

9. To return Baud, Parity, and Bit Length to their original settings, click Default. 
10. Click OK or press ENTER    to return to the Connectivity Packs dialog box. 

Receiving Files
1. Choose Connect from the File menu.

2. Choose Connect the Connectivity Pack Main Menu

3. Choose the    Receive button.

4. Enter a filename and path. If you give the file a .LCW extension, Lucid 3-D automatically converts
the file to Lucid 3D for Windows. If you give the file a .BS2 extension, Lucid 3-D stores the file on 
your computer, but it remains a Casio file. You can open it in Lucid 3-D by choosing Open from 
the File menu. Lucid 3-D converts it when you open it. Click OK or press ENTER. A Status dialog 
box appears.

5. The Status dialog box is updated as the data transmits. It indicates the percentage complete, the 
Efficiency percentage, the number of Blocks transmitted, the number of Errors encountered, 
and the errors Corrected. A special Status box explains exactly what is happening throughout 
the transmission. 

6. The Status box indicates the successful transfer when the transmission is complete.

7. Choose the OK button to return to the spreadsheet.

Sending Files
1. To send Lucid 3-D for Windows files to a palmtop computer, choose Connect from the File menu.

2. Choose the Connect button to view the Connectivity Pack Main Menu.

3. Choose the Send button. 

4. Enter the name and path of the file you want to send. If the file has a .BS2 extension, Lucid 3-D 



just copies it to the palmtop computer. Lucid 3-D converts files with the .LCW extension to the 
palmtop's native format. Click OK or press ENTER. A Status dialog box appears.

5. The Status dialog box is updated as the data transmits. It indicates the percentage complete, the 
Efficiency percentage, the number of Blocks transmitted, the number of Errors encountered, 
and the errors Corrected. At the end of transmission, if more errors are encountered than 
corrected, delete the file from the SF Unit and resend it. A special Status box explains exactly 
what is happening throughout the transmission. 

6. When the transmission completes, the Status box indicates a successful transfer.

7. Choose the OK button 



Copying and saving data in a different file
1. Switch to the spreadsheet containing the information to copy.

2. Select the range of information to copy.

3. Choose Copy from the Edit menu.

4. Switch to the spreadsheet you want to paste the information to.
You may want to save the information to a new file. Choose New from the File menu to create a 
new spreadsheet.

5. Position the widebar at the upper left corner of the range where you want the copy to occur.

6. Select Paste from the Edit menu.



Copying and pasting data from a note
1. Select the cell containing the note.

2. Choose Note from the Edit menu.
Shortcut: F3

3. Choose Copy from the Edit menu.

You can paste the data from the note into other applications, or other parts of the spreadsheet.



Creating a graph
1. Select the range of cells to graph.

2. Choose Graph from the Graphics menu.

3. Choose Create from the Graph menu.

4. Select the graph type.

5. Select embedded to create a graph as an embedded graph on the 
spreadsheet.



Creating a floating Button Bar
Floating Button Bars allow you to access command quickly. When you create a floating Button Bar, the 
buttons on the Button Bar are contained in a window which can be moved around the screen.

1. Choose Button Bars from the Tools menu.

2. Select the Button Bar you want.

3. Choose Show.

-or-

· With the Button Bar visible, click the thumb tack button (the last button on the right side of the 
Button Bar)

To close the Button Bar window, click the X on the top of the Button Bar window.



Creating a floating object
1. Choose Draw from the Graphics menu.

2. Choose the floating object to draw.

3. Position the mouse pointer to the start of the drawing.

4. Drag the mouse pointer until the object is the shape you want.



Creating a pushbutton
1. Choose Draw menu from the Graphics menu.

2. Choose Push Button from the Draw menu.
The cursor changes to the Push Button cursor.

3. Position the mouse pointer to the start of the drawing.

4. Drag the mouse pointer until the object is the shape you want.



Creating a note
1. Select the cell for the note.

2. Choose Notes from the Edit menu.
Shortcut: F3

3. Type in the note.

4. Choose the OK button.



Cutting, copying and pasting
To cut a selection and place it in the Clipboard

1. Highlight the cell or range.

2. Choose Cut from the Edit menu.
Shortcut: CTRL+X

To copy a selection and place it in the Clipboard
1. Highlight the cell or range.

2. Choose Copy from the Edit menu.
Shortcut: CTRL+C



Deleting a floating object
1. Select the floating object.

2. Press DEL



Deleting a note
1. Select the cell containing the note to delete.

2. Choose Notes from the Edit menu.
Shortcut: F3

3. Choose the Remove button.



Deleting a pushbutton
1. Select the push button to delete.

2. Press DEL.



Deleting cells, rows, and columns
1. Select the range you want to delete.

2. Choose Delete from the Range menu.

3. Choose rows, columns or layers.

4. Choose partial (to insert only in the range you selected) or entire to insert entire rows, columns or 
layers.

5. Choose the Contents option if you want to shift the contents of the highlighted cells.

6. Choose the Formats option if you want to shift the formats of the highlighted cells.

7. Choose the OK button.



Entering text
1. Select the cell to place the text.

2. Type the text.
The text appears in the cell editor as you type.

3. Choose the Enter box (check mark) or press ENTER.



Entering values
1. Select the cell to place the value.

2. Type the value.

3. Choose the Enter box (check mark) or press ENTER.



Erasing cell contents
Erasing cell contents deletes all cell formatting (borders, colors, etc.) as well as the cell contents.

1. Select the cells to erase.

2. Press DEL.



Finding information on your spreadsheet
1. Choose Find from the Edit menu.

Shortcut: F4

2. Type the text to search for in the Find box.

3. Select Ignore Case for a case-insensitive search.

4. Select Formulas to locate the text in formulas.

5. Select Partial to locate the text which is part of other text. 
For example, to find "To" in "Today", select Partial.



Formatting text and numbers
1. Select the cells you want to format.

2. Choose Format from the Range menu.

3. Choose the options to change.

4. Choose the OK button.



Hiding and unhiding windows
You can hide and unhide windows from view. Hiding windows can be useful when using the Tile 
command. You can limit the number of windows that appear tiled without having to close files you aren't 
finished with.

To hide a window
1. Select the window to hide.

2. Choose Hide from the Windows menu.

To unhide a window
1. Choose Unhide from the Windows menu.

2. Select the window from the Hidden Windows list.

3. Choose the Show button.



Importing files
1. Choose Open from the File menu.

2. Choose the file format from the available choices in the List File Types Of list.

3. Choose the drive where the file is located in the Drive list.

4. Choose the directory where the file is located in the Directory list.

5. Choose the file from the Files list.

6. Choose the OK button.



Inserting cells, rows, and columns
1. Select the range to the right or below the range you want to insert.

2. Choose Insert from the Range menu.

3. Choose rows, columns or layers.

4. Choose partial (to insert only in the range you selected) or entire to insert entire rows, columns or 
layers.

5. Choose the Contents option if you want to shift the contents of the highlighted cells.

6. Choose the Formats option if you want to shift the formats of the highlighted cells.

7. Choose the OK button.



Locking and unlocking titles
You can lock labels in the top columns and leftmost rows of the sheet so that they remain in view when 
you scroll the spreadsheet window. When you lock titles, everything above and to the left of the currently 
selected cell is blocked as a title region. As you scroll through the spreadsheet, the titles scroll with the 
window. You can use titles in situations where you have a large spreadsheet that has labels on the top 
and left that would scroll out of the window when you scroll. 

Locked titles also print with the spreadsheet when row and column labels apply to several pages on your 
printed spreadsheet.

To lock spreadsheet titles
1. Select the cell below and to the right where you want to set titles.

2. Choose Titles from the Windows menu.

To unlock spreadsheet titles
· Choose Titles from the Windows menu.



Moving floating objects
1. Select the floating object to move.

2. Drag the floating object to its new location.



Naming a range of cells
Naming ranges allows you to assign a name to identify a cell or range of cells. Range names can replace 
cell and range references in functions and formulas. You can use descriptive names, like "Sales" or "Main 
Office", or even long names like "Total Sales of Spare Parts".    

Naming a range of cells
1. Select the range to name.

2. Choose Name from the Range menu.

3. Type in a name for the range in the Name box.
Range names can be up to 255 characters including spaces.

4. Choose the OK button.

Naming multiple ranges of cells
1. Select the first range to name.

2. Choose Name from the Range menu.

3. Type in a name for the first range in the Name box.

4. Choose the Add button.

5. Type in the name for the next range in the Name box.

6. Type in the range for the name.

7. Choose the Add button.

8. Repeat steps 3 through 7 until you have added all the range names.

9. Choose the OK button.



Naming layers
Lucid 3-D for Windows uses tabs to identify spreadsheet layers and labels them with letters of the 
alphabet. You can rename these tabs, using up to 255 characters for each tab. For example, for the layer 
containing expenses for travel, you could name it "Travel Expenses".

To name a layer
1. Choose Name Layers from the Tools menu.

Shortcut: click the right mouse button over the Tab

2. Select the tab to name.

3. Type in the new name for the tab.

4. Select a color for the tab.

5. You can name any tab without exiting the spreadsheet.

6. Click the OK button.



Opening a spreadsheet
1. Choose Open from the File menu.

Shortcut: CTRL+F12
 The Open dialog box appears. Lucid 3-D displays the files in the current directory. To show files 
in a different drive or directory, select the drive and directory. If you are importing a file, select the 
appropriate file type in the List Files of Type list.

2. Type in the file name, or select it from the Files list.

3. Choose the OK button.



Pasting data into a note
You can paste data from the spreadsheet, or other applications, into the note of a cell.

To paste data into a note
1. Copy the data you want to paste into the note.

2. Select the cell containing the note to paste to.

3. Choose Note from the Edit menu.
Shortcut: F3

4. Press CTRL+V or CTRL+INS.



Previewing a spreadsheet
Use the Print Preview command to view spreadsheet pages as they will appear printed.

To preview the printed spreadsheet
1. Choose Print Preview from the File menu.

Shortcut: Print Preview button

2. To print the page from the Print Preview window, choose the Print button.

3. To view other pages of the spreadsheet, select the page in the Page box.



Printing a graph
1. Select the graph to print.

2. Choose Print from the File menu.

3. Set any print options.

4. Choose the OK button.



Printing cell notes
1. Choose Page Setup from the File menu.

2. Select Notes.

3. Choose OK.

4. Choose Print from the File menu.

5. Select any print options and choose the OK button.

Notes are printed on a separate page from the spreadsheet data listed by its cell reference.



Printing a spreadsheet
1. Choose Page Setup from the File menu if you want to set printed page options (headers, footers, 

margins, etc.)

2. Choose Print Setup from the File menu if you want to set print options.

3. Choose Print Preview from the File menu if you want an on-screen view of the printed page.

4. Choose Print from the File menu.

5. Set the print options and choose the OK button.



Recording a macro
To record a macro, turn on the macro recorder and perform the commands and keystrokes you want the 
macro to perform. The macro recorder enters each command and keystroke in the macro for you. 

Lucid 3-D stores the commands and keystrokes into the macro sheet as a macro function. When you run 
the macro, the macro functions perform the commands and keystrokes. Each cell that you edit requires 
one cell in the macro sheet and each command requires another cell. You can record up to 1000 
commands in each macro. 

Lucid 3-D normally records macros using relative references. You can modify 
Lucid 3-D default settings to record absolute layers (always the same layer), absolute columns (always 
the same column), absolute rows (always the same row), or any combination of absolute and relative 
references. See for information on absolute and relative references, see the Using absolute and relative 
cell references help topic.

Recording a Macro
1. Choose the Create command from the Macro menu.

2. Type a descriptive name for the macro.

3. (Optional) Choose the Options button.
The Record Options dialog box allows you to specify whether the references used to create the 
macro are absolute or relative.

4. Press ENTER or click the Record button.

5. Perform the actions you want to record.

6. Choose Stop from the Macro menu to end the recording session.

Recording Over an Existing Macro
After using a macro, you may want to record different actions for the macro. To re-record the macro:

1. Choose Create command from the Macro menu.

2. In the Create Macro dialog box, select the name of the macro to re-record.

3. Choose the Record button.
A dialog box appears asking if you want to overwrite the macro.

4. Choose the Yes button.

5. Perform the actions you want to record.

6. Choose the Stop command from the Macro menu.



Replacing data on your spreadsheet
Use the Replace command to find data in your spreadsheet and optionally replace it with something else. 
See the Finding data on your spreadsheet help topic, to find data on your spreadsheet without replacing 
it.

To replace spreadsheet data
1. Choose the Replace command from the Edit menu.

Shortcut:SHIFT+F4

2. Type in the text to find in the Find box.

3. Type in the text to replace in the Replace box.

4. If the case of the find text doesn't matter, select Ignore case.

5. If the you want to find text that is part of other words or numbers that are part of formulas, select 
Partial.

6. Choose Replace to replace the first occurrence of the find text.

7. Choose Replace All to replace all occurrences of the find text.



Resizing floating objects
1. Select the floating object to size.

2. Use the sizing handles to size the floating object, drag the mouse pointer to the new size.



Running a macro
To Run a Macro Using Run command

1. Select the Run command from the Macro menu.

2. In the Macro Run dialog, select the name of the macro to run.

3. Choose the OK button.

To Run a Macro From A Push Button
1. Assign a macro to the push button if you have not already done so.

2. Click the push button.

Canceling Macro Execution
1. Press ESC

The Cancel Macro dialog box appears, asking you if you want to cancel the macro. You may 
choose to go to the cell where the macro stopped, or continue playing the macro.

2. Click the Stop button.



Saving a spreadsheet 
Saving a spreadsheet for the first time

1. Choose Save from the File menu.
Shortcut: SHIFT+F12

2. Type in a file name.

3. Choose the OK button.

Saving a spreadsheet to the same name
· Choose Save from the File menu.

Saving a spreadsheet to a different name, file type, or location
1. Choose Save As from the File menu.

Shortcut: F12

2. If you want to change the file name, type in a new file name.

3. If you want to change the file type, select the type from the List Files of Type list.

4. If you want to change the directory of the file, select the directory from the Directories list.

5. If you want to change the drive, select the drive from the Drives list.



Selecting, creating or deleting a numeric format
To select a numeric format

1. Select the cells for the format.

2. Choose Format from the Range menu.

3. Choose Numeric from the Format menu.

4. Select the numeric format from the Format list.

5. Choose OK.

To create a numeric format
1. Select the cells for the format.

2. Choose Format from the Range menu.

3. Choose Numeric from the Format menu.

4. If you want to change an existing format, choose the format from the Format list.

5. If you want to create a new numeric format, choose the Add button.

6. Type in the format codes in the Sample text box.

7. Choose OK.

To delete a numeric format
1. Choose Format from the Range menu.

2. Choose Numeric from the Format menu.

3. Select the numeric format to remove from the Format list.

4. Choose Remove.

Note: Removing a numeric format will cause any number formatting with the removed formatting to 
change numeric formats.



Selecting cells, rows, columns 
To select a single cell

· Click on the cell or use the arrow keys to move to the cell you want.

-or-

1. Choose Edit|Goto (F5).

2. Type in the cell address.

3. Choose the OK button.

To select a range of cells
· Drag from the first cell to the last cell of the selection.

-or-

1. Select the first cell of the range.

2. Hold down SHIFT or press F8.

3. Press the arrow keys to select the range.

4. Release SHIFT or press F8 to finish selecting.

To select an entire row or column
· Click the row or column heading



Selecting layers
Selecting a layer using the mouse

· Click the left mouse button on the layer name.

Selecting a layer using the Goto command
1. Choose Edit|Goto (F5).

2. Type in the layer name.



Selecting floating objects
1. Locate the floating object on the spreadsheet.

2. Move the mouse pointer over the floating object.

3. Click the left or right mouse button.

Clicking the right mouse button will simultaneously show the floating object 
right-click menu.



Setting global preferences
Setting global preferences affect the entire Lucid 3-D for Windows application. Some options affect new 
spreadsheets, others affect every spreadsheet you open. To set the options for the active spreadsheet, 
see the Setting sheet preferences help topic.

To set global preferences
1. Choose Global Preferences from the Tools menu.

2. Select the options for the Lucid 3-D for Windows environment.

3. Choose the OK button.



Setting spreadsheet preferences
Setting spreadsheet preferences affect the currently active spreadsheet window. See the Setting Global 
Preferences help topic to control options for all spreadsheets.

To set spreadsheet preferences
1. Choose Sheet Preferences from the Tools menu.

2. Select the options for the spreadsheet.

3. Choose the OK button.



Setting the default font for your spreadsheet
1. Choose Sheet Preferences from the Tools menu.

2. Choose the Font button.

3. Select the font and formatting options.

4. Choose OK.

5. Choose OK.



Setting up your printer
1. Choose Printer Setup from the File menu.

2. To change printers, select the printer from the Specific Printer list.

3. To change printer options, choose the Options button.
Choose the Help button on the Options dialog for specific printer options.



Showing cells with notes
1. Choose Sheet Preferences from the Tools menus.

2. Select Notes.

3. Choose OK.

Cells that contain notes will display a small dot in the upper left hand corner of the cell.



Sorting rows, columns and layers
You can sort selected ranges of your spreadsheet without affecting cells entries outside the selected 
range.

1. Select the range of cells to sort.
Make sure that you are including all cells you want to sort. Cells outside the range will not be 
sorted.

2. Choose Sort from the Range menu.

3. Select the method, by Rows, by Columns, or by Layers.

4. Select Ignore Case if you want to sort without regard to case sensitivity.

5. Type the cell reference of your first sort key in 1st.

6. If you want to sort by more than one key, type in the cell reference of the 2nd and 3rd sort keys.

7. Select either ascending or descending for each key selected.

8. Choose OK.



Transposing rows and columns in a graph
1. Select the graph window.

If your graph is not in a graph window, double-click the graph.

2. Choose Graph Elements from the Format menu.

3. Select Transpose Rows and Columns.

4. Choose the OK button.



Viewing cells as formulas
1. Choose Sheet Preferences from the Tools menu.

2. Select Formulas.

3. Choose the OK button.



Product Support
Lucid Customer Support 
Contact    Customer Support:

· for upgrade information and ordering.

· for referrals to dealers close to you.

· for problems with the package (missing or defective pieces).

· for general information about Lucid and our products.

Lucid Corporation
101 W. Renner Rd. Ste 450
Richardson, TX 75082
Attn: Customer Support

(800) 925-8243 in the U.S.A. and Canada
(214) 994-8100 All others
(214) 994-8103 Fax
Lucid Product Support 
Lucid Product Support is available for support on Lucid 3-D for Windows. If you have a question about the
operation or function of Lucid 3-D for Windows product, contact Product Support as listed below. 

When calling Product Support, do the following before you call:

· Be at your computer.

· Write down what you were doing when the problem occurred.

· Write any error messages that Lucid 3-D for Windows displayed.

· Have your serial number available. 
Lucid Corporation
101 W. Renner Rd., Ste. 450
Richardson, TX 75082
Attn: Lucid 3-D for Windows Product Support
(214) 994-8101, 8:30am to 5:30pm (CST)
Monday through Friday
(214) 994-8103 (FAX)

Lucid On-Line Services (Available October 1993)
You may get information electronically by accessing Lucid's corporate bulletin board system (BBS). 
Setting for Lucid's BBS are: 300,1200,2400,or 9600 baud; 8 bits, 1 stop bit; no parity.

(214) 994-8125 

Includes a Customer Service forum, public-domain software, and support forums on: Third Dimension, 
Lightning, Lightning for Windows, Lightning CD, Battery Boost, Battery Boost Notebook Utility Pack, Lucid
3-D for DOS and Lucid for Windows.

Compuserve
You may also get information electronically by accessing the Windows Vendor A forum (GO WINAPA). 
You may also leave us e-mail on Compuserve at 72662,305.



Numeric Formatting Codes
Format 
Symbol

Explanation

0 Prints a digit if it exists; otherwise prints "0".
# Prints a digit if it exists; otherwise leaves a blank space. # must precede 0's 

on the integer portion of a number and follow 0's on the fractional portion. 
, (comma) Adds commas every three digits. If placed after a #, it leaves a space if not 

used.
. (decimal) Specifies the beginning of a fractional portion of a number.    Lucid 3-D allows 

one per format string.
? One or more ?'s, prints 1 digit of the fractional portion of a number for each ?. 

This truncates the integer portion of the number.
?/? One or more ?'s, followed by zero or more spaces, followed by / ,followed by 

zero or more spaces, followed by one or more ?'s defines a fraction. Lucid 3-
D represents the fractional part of the number by the closest fraction with the 
given number of digits in the denominator. This truncates the integer portion 
of the number. For example, the format "0 and ??/??" and the value 9.876543
yields "9 and 71/81".

e or E Specifies the beginning of an exponential portion. E is followed by an optional
+ or -    and you must include one or more # 's or 0's. #'s must precede any 
0's. E is only valid when you enter it immediately following a number.

% When following a number, % multiplies the number by 100, and prints the %. 
+ (plus) Prints the sign of the number or leaves a blank space if the number is zero. 

Lucid 3-D allows one sign format symbol per format string.
- (minus) Prints a "-" if the number is negative and leaves a blank space if the number 

is positive or zero. 
( ) Prints the parentheses around the number if the number is negative, prints 

blank spaces otherwise. ( ) must surround a number.
[ ] Prints the brackets around the number if the number is negative, prints blank 

spaces otherwise. ( ) must surround a number.
; 
(semicolon)

Separates format strings. If only one string exists, Lucid 3D uses it for all 
numbers. If two exist, the first formats negative numbers, the second formats 
for positive. If three exist, the first formats negative values, the second 
formats 0 values, and the third formats positive values.

{color} Changes the color of the number. Color can be Black, Navy, Silver, Blue, 
Maroon, Purple, Red, Fuchsia, Green, Teal, Lime, Aqua, Olive, Gray, Yellow, 
or White. Lucid 3D allows one color per format string. 

{Th} Prints "st", "nd", or "rd" if the last integer digit preceding {TH} is a 1, 2, or 3    
(and the tens digit is not 1). Prints "th" otherwise.

{Roman} Prints the integer portion of the number in Roman numerals. Note that the 
case of Roman numerals is significant. The digits i, v, x, l, c, d, and m are 
used for 1, 5, 10, 50, 100, 500 and 1000. The digits V, X, L, C, D and M are 
used for 5000, 10000, 50000, 100000, 500000, and 1000000. The case 
distinction is necessary because windows can't print the characters that 
normally represent 5000 - 1000000 (V, X, L, C, D and M superimposed with a 
horizontal line). 

{TextInt} Prints the integer portion of the number in text ("Three"). Enter {textint} to print
in lowercase ("three").



{TextIntTh} Prints the integer portion of the number as an ordinal in text (Third). Enter 
{textintth} to print with no capitalization (third). 

{TextFract,#
}

Prints the fractional portion of the number in text. # is the number of digits of 
precision to use (One Tenth). Enter {textfract,#} to print with no capitalization 
(one tenth).

\ 
(backslash)

Considers it the next character as text.    Used to cause other special 
characters to appear literally. Normal text does not need require this symbol. 



Edit menu commands
Undo
Cut
Copy
Paste
Paste Special
Delete
Find
Replace
Goto
Notes



Undo command (Edit menu)
Use the Undo command to cancel most command and actions. 

Shortcuts
ALT+BKSPC

CTRL+Z



Cut command (Edit menu)
Use the Cut command to remove the current selection and its formatting and place it in the clipboard. 
Cutting selections replaces the previous contents of the clipboard.

Shortcuts

SHIFT+DEL
CTRL+X



Copy command (Edit menu)
Use the Copy command to copy the current selection to the clipboard. The selection can be a cell, range, 
graph, floating object or cell editor. 

Shortcuts: 

 
CTRL+C
CTRL+INS

Related Topics
Copying and saving data in a different file
Copying data from a note



Paste command (Edit menu)
Use the Paste command to insert the contents of the clipboard onto the current selection. To paste only 
certain properties from the clipboard, use the Paste Special command (Edit menu). 

Shortcuts

CTRL+V
SHIFT+INS
Related Topics
Paste Special command (Edit menu)
Pasting data into a note
Copying and saving data in a different file
Copying and pasting data from a note
Pasting data into a note



Paste Special command (Edit menu)
Use the Paste Special command to paste specific information from the clipboard onto the current 
selection. 

Shortcuts

CTRL+S
Dialog Box Options

Formats Select Formats to paste any formatting 
information contained in the clipboard contents.

Contents Select Contents to allow for how to paste the 
clipboard information on the spreadsheet. Select 
Formulas to paste the formula. Select Values to 
paste the result only.

Delete command (Edit menu)
Use the Delete command to erase cell contents and formats. 

Shortcut
DEL



Find command (Edit menu)
Use the Find command to search the spreadsheet for information. 

Shortcuts
F4

Dialog Box Options
Find Type in the text or numbers you want to search 

for.
Ignore case Select Ignore case to ignore the case of the 

search.
Formulas Select Formulas to search through formulas also.
Partial Select Partial if you want to locate the find text, 

even if it is part of another word or number.

Replace command (Edit menu)
Use the Replace command to search for information and optionally replace it with other information.

Shortcuts
SHIFT+F4

Dialog Box Options
Find Type in the text or numbers to search for.
Replace Type in the text or numbers to replace the Find text 

with.
Ignore case Select Ignore case for a case-insensitive search.
Partial Select Partial to find the Find text incased in other 

words or numbers.

Goto command (Edit menu)
Use the Goto command to move the widebar to specific cell, named range or another layer on the 
spreadsheet.

Shortcuts
F5

Dialog Box Options
Range Type in the cell or range you want to move to.
Goto History A list of Goto commands performed. You can 

double-click a reference in this list.

Notes command (Edit menu)



Use the Notes command to enter text that provides comments about a cell, but has no effect on the actual
cell. Notes are useful for explaining cell contents to other users or as a reminder to yourself.

Shortcuts
F3

Dialog Box Options
Cell Lists the cell which this note is attached to.
Note box Type in the text of the note entry.

File menu commands
New
Open...
Save
Save As...
Close
Print Preview...
Page Setup...
Print
Print Setup
Connect...
Exit



New command (File menu)
Use the New command to create an empty spreadsheet with default options. The spreadsheet is open in 
a new window. 



Open command (File menu)
Use the Open command to open existing spreadsheet into a new window. You can have more than one 
spreadsheet open at a time. In addition to opening Lucid 3-D for Windows files, you can also import files 
of different file formats (e.g. XLS, WKS). 

Shortcuts

CTRL+F12
Dialog Box Options

File Name Type the file name and extension of the file to open. 
The file name can have eight characters plus a three 
character extension. Any characters that are valid for a 
DOS file name are acceptable. 
Lucid 3-D for Windows defaults to an extension of LCW 
for any Lucid 3-D spreadsheet. You can use any valid 
DOS extension.

List Files of Type Displays a list of available file types. When you select a 
file type, the File Name list reflects that selection.

Directories Displays a list of available directories. When you select 
a directory, the File Name list reflects that selection.

Drives Displays a list of available drives. When you select a 
drive, the Directories and File Name lists reflect that 
selection.

Save command (File menu)
Use the Save command to save an existing document to the same file name, file type and file location. 
The first time you save a spreadsheet, Lucid 3-D displays the Save As dialog box, so you can name the 
spreadsheet. To change the file name, file type, or file location, use the Save As command.

Shortcuts

SHIFT+F12
Dialog Box Options

File Name Type a new file name and extension. The file name can 
have eight characters plus a three character extension. 
Any characters that are valid for a DOS file name are 
acceptable. Lucid 3-D for Windows defaults to an 
extension of LCW for any Lucid 3-D spreadsheet. You 
can use any valid DOS extension.

List Files of Type Displays a list of available file types. When you select a 
file type, the File Name list reflects that selection.

Directories Displays a list of available directories. When you select 
a directory, the File Name list reflects that selection.

Drives Displays a list of available drives. When you select a 
drive, the Directories and File Name lists reflect that 
selection.

Related Topics



Save As(File menu)



Save As command (File menu)
Use the Save As command to save and name an untitled (new) spreadsheet or to save a copy of an open
spreadsheet under a new name. All changes made to the spreadsheet are saved, and you can continue 
working on the spreadsheet under its new name. Use the Save command to save changes to the same 
file name, file type, and file location.

Shortcuts

 (first time you save the document)
F12
Dialog Box Options

File Name Type a new file name and extension. The file name can 
have eight characters plus a three character extension. 
Any characters that are valid for a DOS file name are 
acceptable. Lucid 3-D for Windows defaults to an 
extension of LCW for any Lucid 3-D spreadsheet. You 
can use any valid DOS extension.

List Files of Type Displays a list of available file types. When you select a 
file type, the File Name list reflects that selection.

Directories Displays a list of available directories. When you select 
a directory, the File Name list reflects that selection.

Drives Displays a list of available drives. When you select a 
drive, the Directories and File Name lists reflect that 
selection.

Related Topics
Save command (File menu)



Close command (File menu)
Use the Close command to close the active document window. Lucid 3-D will prompt you to save any 
changes before closing the window. Changes made since the last save will be lost. 



Print Preview command (File menu)
Use the Print Preview command to switch in and out of Print Preview mode. Print Preview mode allows 
you to view the printed spreadsheet with all header, footer and other page setup options. 

Shortcuts

Related Topics
Previewing a spreadsheet



Page Setup command (File menu)
Use the Page Setup command to set the appearance of the printed spreadsheet.

Dialog Box Options
Margins Specify margins in inches for Top, Bottom, Left, Right, Header, 

and Footer. Headers are measured from the top margin. 
Footers are measured from the bottom margin. 

Center cells Select Center Cells to horizontally center spreadsheet columns 
on the printed page. 

Paper Size Select the size of the paper.
Orientation Select the orientation of the printed page. Portrait prints down 

the length of the paper, Landscape prints across the width of 
the paper.

Attributes Select the attributes to appear on the printed page. 
Grid Select Grid to print the lines separating columns and rows in the

spreradsheet. 
Fill Page Select Fill Page to fill empty areas of the page with grid lines.
Notes Select Notes to print any notes contained in the file. Notes will 

be printed on separate pages with cell references.
Advanced Additional page setup options.
Header Specify the header for the printed page.
Footer Specify the footer for the printed page.
Preview Choose Preview to see an on-screen representation of the 

printed page.
Printer Choose Printer to set the printer to print to.
Print Choose Print to print the spreadsheet according to the options 

you have selected.

Print command (File menu)
Use the Print command to print the active spreadsheet. Use the Page Setup command to set the 
attributes of the printed page.

Shortcuts

Dialog Box Options
Printer Shows the currently selected printer.
Print Range Select the All button to print the entire spreadsheet. Select 

Selection to print the current selection. Select Pages to print a 
specific page range.

Print Quality Select the resolution of the printed page. Lower resolutions print 
faster.

Copies Type in the number of copies to print.
Collate Copies Select to print one full set of pages before printing the next set.
Setup Display the Print Setup dialog box. (same as Print Setup 



command (File menu))

Related Topics
Adding headers and footers
Printing a spreadsheet



Print Setup command (File menu)
Use the Print Setup command to select the printer and options for printing a spreadsheet or graph.

Dialog Box Options
Printer Select the Default Printer or a specific printer. Only installed

printers show in the Specific Printer list. See your Windows 
documentation on installing printers.

Orientation Select the orientation of the printed page. 
Paper Select the paper source and paper size.
Options Displays a dialog box so you can control printer specific 

settings. Click the Help button in the Options dialog box for 
help.

Related Topics
Printing spreadsheets



Connect command (File menu)
Use this command to connect to Palmtop, Handheld or Personal Digital Assistant computers. 

Dialog Box Options
Installed Packs Displays a list of installed Connectivity Packs.
Connect Connects to the remote computer using the highlight 

connectivity pack.
Close Exits the dialog box.
Add Add a new Connectivity Pack to Lucid 3-D for Windows.
Remove Remove a Connectivity Pack from Lucid 3-D for Windows.

Related Topics
Connecting to a palmtop, handheld, or PDA computer



Exit command (File menu)
Use the Exit command to quit Lucid 3-D for Windows. If you have made any changes to open 
spreadsheets, Lucid 3-D for Windows will suggest that you save the changes for each spreadsheet.

Shortcut
ALT+F4



Graphics menu commands
Draw menu
Graph menu



Draw menu (Graphics menu)
Line
Polyline
Curve
Oval
Rectangle
Rounded Rectangle
Polygon
Filled Curve
Filled Oval
Filled Rectangle
Filled Rounded Rectangle
Filled Polygon
Push Button



Line command (Draw menu)
Use the Line command to draw a straight line on your spreadsheet.

Related Topics
Creating a floating object
Deleting a floating object
Resizing floating objects



Polyline command (Draw menu)
Use the Polyline command to draw a floating object composed of multiple connected lines on the 
spreadsheet. To draw a freeform line, keep the left mouse button pressed.

Related Topics
Creating a floating object
Deleting a floating object
Resizing floating objects



Curve command (Draw menu)
Use the Curve command to create one fourth of an oval or circle on the spreadsheet.

Related Topics
Creating a floating object
Deleting a floating object
Resizing floating objects



Oval command (Draw menu)
Use the Oval command to create ovals and circles on the spreadsheet.

Related Topics
Creating a floating object
Deleting a floating object
Resizing floating objects



Rectangle command (Draw menu)
Use the Rectangle command to create squares and rectangles on the spreadsheet.

Related Topics
Creating a floating object
Deleting a floating object
Resizing floating objects



Rounded Rectangle command (Draw menu)
Use the Rounded Rectangle command to create rectangles with rounded corners.

Related Topics
Creating a floating object
Deleting a floating object
Resizing floating objects



Polygon command (Draw menu)
Use the Polygon command to create objects with multiple sides. To draw freeform with the Polygon 
command, hold down the left mouse button while drawing the polygon.

Related Topics
Creating a floating object
Deleting a floating object
Resizing floating objects



Filled Curve command (Draw menu)
Use the Curve command to create one fourth of an oval or circle with the background filled with the 
background color and pattern on the spreadsheet.

Related Topics
Creating a floating object
Deleting a floating object
Resizing floating objects



Filled Oval command (Draw menu)
Use the Oval command to create ovals and circles with the background filled with the background color 
and pattern.

Related Topics
Creating a floating object
Deleting a floating object
Resizing floating objects



Filled Rectangle command (Draw menu)
Use the Rectangle command to create squares and rectangles with the background filled with the 
background color and pattern on the spreadsheet.

Related Topics
Creating a floating object
Deleting a floating object
Resizing floating objects



Filled Rounded Rectangle command (Draw menu)
Use the Rounded Rectangle command to create rectangles (rounded corners) with the background filled 
with the background color and pattern on the spreadsheet.

Related Topics
Creating a floating object
Deleting a floating object
Resizing floating objects



Filled Polygon command (Draw menu)
Use the Polygon command to create objects with multiple sides with the background filled with the 
background color and pattern. To draw freeform with the Polygon command, hold down the left mouse 
button while drawing the polygon.

Related Topics
Creating a floating object
Deleting a floating object
Resizing floating objects



Push Button command (Draw menu)
Use the Push Button command to create a rectangular object that resembles a button. You can assign 
macros to a push button.

Related Topics
Assigning macros to push buttons
Creating a pushbutton
Deleting a push button



Graph menu (Graphics menu)
Create
Edit



Create command (Graph menu)
Use the Create command to create an embedded graph in the spreadsheet. 

Dialog Box Options
Graph Type Select a graph from the 12 supported graph types
Embedded Select Embedded to create an embedded graph in the 

spreadsheet.

Related Topics
Adding axes grids to graphs
Adding graph titles
Changing colors and patterns in a graph
Changing graph fonts
Changing graph types
Creating a graph
Printing a graph



Edit command (Graph menu)
Use the Edit command to modify the currently selected floating (embedded) graph. The Edit command 
will places the graph in a graph window where you can edit it.

Related Topics
Adding axes grids to graphs
Adding graph titles
Changing colors and patterns in a graph
Changing graph fonts
Changing graph types
Creating a graph
Printing a graph



Help menu commands
Contents
Search
Functions
Product Support
About Lucid 3-D for Windows



Contents command (Help menu)
Use this command to display the Lucid 3-D for Windows Help table of contents. To select a topic from the 
table of contents, click the name of the topic. You can also press the tab key to move to the topic and 
press ENTER.

If you need help using the Help system, use the Help on Help command.



Search command (Help menu)
Use the Search command to search Help topics by typing or selecting available keywords.

Dialog Box Options
Keyword Select a keyword from the list, or type a 

keyword in.
Topics Select a topic from the list and choose Goto.

Functions command (Help menu)
Use the Functions command to display the Functions help topic.

Related Topics
Functions



Product Support command (Help menu)
Use the Product Support command for viewing details on contacting Lucid Corporation.



About Lucid 3-D for Windows (Help menu)
Use the About Lucid 3-D for Windows command to display information about this version of Lucid 3-D for 
Windows.



Macro menu commands
Create
Stop
Play
Edit
If
Else
Endif



Create command (Macro menu)
Use the Create command to record a new macro or overwrite an existing macro.

Dialog Box Options
Name Type in a name or select one from the Macro 

list.
Record Choose this button to begin recording the 

macro.
Options Choose this button to set macro options.

Related Topics
Recording a macro
Running a macro



Stop command (Macro menu)
Use the Stop command to stop the recording of a macro. This command is unavailable unless you are 
recording a macro.

Related Topics
Recording a macro
Running a macro



Play command (Macro menu)
Use the Play command to play a macro. You must first record the macro use the Record command 
(Macro menu).

Dialog Box Options
Macro List Select the macro to play from the list.
Play Choose Play to run the macro.

Edit command (Macro menu)
Use the Edit command to trace through the steps of a macro.

Dialog Box Options
Trace 
Execution

Select to step through the execution of a 
macro.

If command (Macro menu)
Inserts an IF statement in the currently recording macro. 



Else command (Macro menu)
Inserts an ELSE statement in the currently recording macro.



Endif command (Macro menu)
Inserts an END statement in the currently recording macro.



Range menu commands
Format menu
Size
Name
Insert
Delete
Sort
Transpose



Format menu (Range menu)
Font
Alignment
Border
Pattern
Numeric



Font command (Format menu)
Use the Font command to change the font, style and color of the text in the current selection. 

Shortcuts

CTRL+T
Cell right-click menu
Dialog Box Options

Font Select the name of the font you want to use or type 
the font name.

Font Style Select a style for the font.
Size Select a size for the font or type in a new size.
Strikeout Select Strikeout if you want lines to appear through 

the font.
Underline Select Underline if you want the font underlined.
Sample Shows a sample of the text using the currently 

selected options.

Alignment command (Format menu)
Use the Alignment command to control the way text and values are positioned in the current selection. 

Shortcuts

CTRL+A
Cell right-click menu
Dialog Box Options

Top Align the cell entries on the top of the cell.
Middle Align the cell entries in the middle of the cell.
Bottom Align the cell entries on the bottom of the cell.
Left Align the cell entries to the left of the cell.
Center Align the cell entries in the middle of the cell.
Right Align the cell entries to the right of the cell.
General Restore the defaults of left alignment of text and right 

alignment of values.

Border command (Format menu)
Use the Border command to add lines that outline a cell or a range of cells. You can use this command to 
highlight specific information in your spreadsheet, or givev visual organization to information. The Border 
command is also available from the cell right-click menu.

Shortcuts

CTRL+B



Dialog Box Options
Outline Puts a border around the selection.
Top Puts a horizontal line on the top of the selection.
Left Puts a vertical line on the left side of the selection.
Bottom Puts a horizontal line on the bottom of the selection.
Right Puts a vertical line on the right side of the selection.

Pattern command (Format menu)
Use the Pattern command to set colors and patterns for the current selection.

Shortcuts

CTRL+R 
Cell right-click menu
Dialog Box Options

Background Set the background color for the current 
selection.

Pattern Set the fill color for the style Selection.
Style Set the fill pattern for the selection.

Numeric command (Format menu)
Use the Numeric command to control the display of values in the current selection. You can use a 
predefined format or create a new format.

Shortcuts

CTRL+N
Dialog Box Options

Formats Lists all the formats available.
Custom Allows you to customize the entry.
Add Add a format to the Formats list.
Remove Remove the selected entry from the Formats list.

Size command (Range menu)
Use the Size command to change column and row size for the selected range. You can size a selection 
by pixel, inches or centimeters.

Dialog Box Options
Height Apply the size to the height of the selection.
Width Apply the size to the width of the selection.
Pixels Set the size in pixel amounts.
Inches Set the size in inch.



Centimeters Set the size in centimeters.

Name command (Range menu)
Use the Name command to assign a name to a cell or range of cells. Range names can replace cell 
references in functions and formulas.

You can use descriptive names, like "Sales" or "Total", names that pertain to your business like 
"Southwest" or "Main Office", or even long names like "Total Sales of Spare Parts".

Once you assign a name to a range of cells, you can use that name in formulas instead of cell references.
For example, you could use SUM(Eastern Region Sales) instead of SUM(C3:C15).

Shortcuts

Dialog Box Options
Name Type in a name for the selected range.
Range The range to apply the name to.
Named 
Ranges

List of currently named ranges.

Insert command (Range menu)
Use the Insert command to insert a row, column or layer the size of the selected range. The selected 
range is shifted to accomodate the inserted cells.

Shortcuts

Dialog Box Options
Insert Select the items to insert.
Partial Inserts only the current selection
Entire Inserts the entire row, column, or layer if selected. 
Contents Shift the contents of cells to fill the space left by the insertion.
Formats Shift the cell formats of cells to fill the space left by the 

insertion.

Delete command (Range menu)
Use the Delete command to remove the selection from the spreadsheet. Cells surrounding the selection 
fill in the space left by the deletion. If you delete entire rows or columns, rows or columns fill the space left
by the deletion.

Shortcuts

Dialog Box Options
Delete Select the items to deletes.
Partial Deletes only the current selection



Entire Deletes the entire row, column, or layer if selected. 
Contents Shift the contents of cells to fill the space left by the deletion.
Formats Shift the cell formats of cells to fill the space left by the 

deletion.

Sort command (Range menu)
Use the Sort command to rearrange spreadsheet entries into a specific order, either ascending or 
descending. 

Dialog Box Options
Range The range to sort. 
Ignore Case Ignore case sensitivity when sorting the selection.
by Layers Sort each layer in the range, keeping layers intact.
by Rows Sort each row in the range, keeping the rows intact.
by Columns Sort each column in the range, keeping the columns 

intact.
1st The first row, column, or layer to arrange by. Select 

Ascending to sort the selection from lowest value to 
highest value.

2nd The second row, column, or layer to arrange by. Select
Ascending to sort the selection from lowest value to 
highest value.

3rd The third row, column, or layer to arrange by. Select 
Ascending to sort the selection from lowest value to 
highest value.

Transpose command (Range menu)
Use the Transpose command to reorder rows, columns, and layers so cells in one dimension are moved 
to another dimension. Transposing rows and columns makes row become columns and columns become 
rows. When transposing layers, rows, and columns, layers become rows, rows become columns, and 
columns become layers. By combining the Transpose and Reverse option together you can rotate ranges.

Shortcuts

Dialog Box Options
Range The range to transpose
Transpos
e

Select the tranpose options

Reverse Create a mirror image of the selected dimension. For 
example, select Rows to make the rows at the top of the 
range appear at the bottom of the range. If you have selected
both a transpose and reverse operation, Lucid 3-D will 
perform the transpose first.



Style menu commands
2-D Pie 
3-D Pie

2-D Bar

3-D Bar

2-D Area

3-D Area

2-D Line

3-D Line

Gantt

Polar

Hi-Lo Close

Scatter X-Y



2-D Pie (Style menu)
Use the 2-D Pie command to create a two-dimensional pie chart. Pie charts are useful for plotting a single
series of data, each element representing a percentage of the whole. The size of each pie slice is the 
approximate percentage each value contributes to the total value.

Related Topics
Adding axes grids to graphs
Adding graph titles
Changing colors and patterns in a graph
Changing graph fonts
Changing graph types
Creating a graph
Printing a graph



3-D Pie (Style menu)
Use the 3-D Pie command to create a three-dimensional pie chart. Pie charts are useful for plotting a 
single series of data, each element representing a percentage of the whole. The size of each pie slice is 
the approximate percentage each value contributes to the total value.

Related Topics
Adding axes grids to graphs
Adding graph titles
Changing colors and patterns in a graph
Changing graph fonts
Changing graph types
Creating a graph
Printing a graph



2-D Bar (Style menu)
Use the 2-D Bar command to create a two-dimensional bar chart. Bar charts are useful for comparing a 
series of values during a related period of time.

Related Topics
Adding axes grids to graphs
Adding graph titles
Changing colors and patterns in a graph
Changing graph fonts
Changing graph types
Creating a graph
Printing a graph



3-D Bar (Style menu)
Use the 3-D Bar command to create a three-dimensional bar chart. Bar charts are useful for comparing a 
series of values during a related period of time.

Related Topics
Adding axes grids to graphs
Adding graph titles
Changing colors and patterns in a graph
Changing graph fonts
Changing graph types
Creating a graph
Printing a graph



2-D Area (Style menu)
Use the 2-D Area command to create a two-dimension area chart. Area charts are variations of the line 
graph in which each value is shown as a contribution of the total value.

Related Topics
Adding axes grids to graphs
Adding graph titles
Changing colors and patterns in a graph
Changing graph fonts
Changing graph types
Creating a graph
Printing a graph



3-D Area (Style menu)
Use the 3-D Area command to create a three-dimension area chart. Area charts are variations of the line 
graph in which each value is shown as a contribution of the total value.

Related Topics
Adding axes grids to graphs
Adding graph titles
Changing colors and patterns in a graph
Changing graph fonts
Changing graph types
Creating a graph
Printing a graph



2-D Line (Style menu)
Use the 2-D Line command to createa a two-dimensional line graph. Line graphs are useful for plotting 
changes in value over a period of time. Each line of the graph represents one value changing over time.

Related Topics
Adding axes grids to graphs
Adding graph titles
Changing colors and patterns in a graph
Changing graph fonts
Changing graph types
Creating a graph
Printing a graph



3-D Line (Style menu)
Use the 3-D Line command to createa a three-dimensional line graph. Line graphs are useful for plotting 
changes in value over a period of time. Each line of the graph represents one value changing over time.

Related Topics
Adding axes grids to graphs
Adding graph titles
Changing colors and patterns in a graph
Changing graph fonts
Changing graph types
Creating a graph
Printing a graph



Gantt (Style menu)
Use the Gantt command to create a Gantt graph. Gantt graphs are useful for plotting project schedules. 
The first value in each column is the offset, or the point where the data in that column begins. The 
remaining numbers in the column make up the time values in the graph.

Related Topics
Adding axes grids to graphs
Adding graph titles
Changing colors and patterns in a graph
Changing graph fonts
Changing graph types
Creating a graph
Printing a graph



Polar (Style menu)
Use the Polar graph command to create a polar graph. A polar graph plots values around a polar axis. 
Each value is plotted in 30 degree increments and represents each row in the range by a line color.

Related Topics
Adding axes grids to graphs
Adding graph titles
Changing colors and patterns in a graph
Changing graph fonts
Changing graph types
Creating a graph
Printing a graph



Hi-Lo Close (Style menu)
Use the Hi-Lo Close command to create a Hi-Lo Close graph. Hi-Lo Close graphs are useful for tracking 
changes in values over a period of time. The graph will plot the high, low, and closing point for each series
of values. Each series is a column of three rows representing the high, low and closing point for the 
series. 

Related Topics
Adding axes grids to graphs
Adding graph titles
Changing colors and patterns in a graph
Changing graph fonts
Changing graph types
Creating a graph
Printing a graph



Scatter XY (Style menu)
Use the Scatter XY command to create a Scatter XY chart. Scatter XY charts are useful for showing 
correlations between different types of values. The graph is plotted using two pairs of rows at a time. In 
each pair of rows, the first row represents the X coordinate and the second row represents the Y 
coordinate. 

Related Topics
Adding axes grids to graphs
Adding graph titles
Changing colors and patterns in a graph
Changing graph fonts
Changing graph types
Creating a graph
Printing a graph



Tools menu commands
Audit

Button Bars

Name Layers

Global Preferences

Sheet Preferences

Functions



Audit command (Tools menu)
Use the Audit command to display lists of various characteristics about the current spreadsheet. The 
Dependents and Sources options list information for a single cell only. If you don't supply a cell address in
Cell Reference, dependents and sources for the current cell location will be used.    

Dialog Box Options
Notes Displays a list of notes contained in the spreadsheet.
Unreferenced Displays a list of cells containing values not used by any 

formula. Lucid 3-D omits cells that appear in formulas as cell 
references, or as part of a range that a function uses. 

Formulas Displays a list of cells in the spreadsheet that contain formulas.
File Links Displays a list of cells containing the REF function.
Dependents Displays a list of cells whose values are dependent on other 

cells.
Sources Displays a list of cells on which the current cell value depends 

on.
Cell Reference Enter a cell address

Button Bars command (Tools menu)
Use the Button Bars command to create a window containing the Button Bar's buttons. When you create 
a Button Bar window, you can have quick access to commands contained in the Button Bar.

Dialog Box Options
Available Button Bars Select the Button Bar you want to be in a moveable 

window.

Name Layers command (Tools menu)
Use the Name Layers command to name spreadsheet layers. You can name each layer with up to 255 
characters. The color of the tab may also be set.

Dialog Box Options
Change Selection to Select the layer name to change and type in a new 

name.
Color Select a new color for the tab selected in Change 

Selection to.

Global Preferences command (Tools menu)
Use the Global Preferences command to configure Lucid 3-D for Windows. Some options affect new 
spreadsheets, others affect every spreadsheet open.

Dialog Box Options



Layers Set the default number of layers for new 
spreadsheets.

Rows Set the default number of rows for new 
spreadsheets.

Columns Set the default number of columns for new 
spreadsheets.

Sheet Preferences Set spreadsheet preferences for new spreadsheets.
Main Button Bar Toggle the main Button Bar on and off.
Undo Available Toggle the Undo feature. When selected you can 

undo most operations or commands using the Undo
command (Edit menu).

Recalculation Select manual or automatic spreadsheet 
calculation. When automatic is selected, the 
spreadsheet is recalculated every time you make 
an entry.

Iterations Sets the number of successive calculations Lucid 3-
D will perform during calculations. You can set the 
number of recalculations between 1 and 100.

Moving Enter Sets the action of the widebar when you press 
ENTER to enter data into a cell. You can also set 
the movement (down, up, left, or right) and the 
distance the widebar travels.

Sheet Preferences command (Tools menu)
Use the Sheet Preferences command to configure settings in the current spreadsheet. To configure 
setting that affect all spreadsheets, see the Global Preferences help topic. 

Dialog Box Options
Notes Displays the first line of any notes in the spreadsheet. 
Formulas Displays the formulas used to calculate the results 

that normally display in the cells.
Grid Displays vertical and horizontal lines that distiguish 

the cell boundaries in the spreadsheet.
Layer References Displays the layer reference as part of cell references 

on the cell edit line. 
Row Labels Displays row labels (1,2,..) down the right side of the 

spreadsheet window.
Column Labels Displays column labels (A,B,C..) across the top of the 

spreadsheet window.
Tabs Displays the layer tabs (A,B,C,...) above the column 

labels. 
Color Tabs Displays tabs in color.
Auto Recalc Recalculates the spreadsheet each time you enter a 

cell entry or press F9. When unchecked, the 
spreadsheet will only recalculate when you press F9.

Font Sets the default font for the spreadsheet
Size Sets the default column width and range height for the



spreadsheet.
Alignment Sets the default justification for the spreadsheet.
Numeric Sets the default numeric format for the spreadsheet.

Functions command (Tools menu)
Use the Functions command to paste a Lucid 3-D built-in function into the cell editor. Choose the function 
from the Available Functions list.

Shortcuts:

Dialog Box Options
Available 
Functions

Select the function to insert or replace.

Insert Insert the selected function on the cell editor line.
Replace Replace the function on the cell editor line with the 

selected function.

Window menu commands
Cascade

Tile

Arrange Icons

Close All

Hide

Unhide

Titles



Cascade command (Windows menu)
Use the Cascade command to arrange document all open windows in overlapping layers with their title 
bars showing. 



Tile command (Windows menu)
Use the Tile command to arrange open windows without overlapping the windows. When possible each 
window is given equal room.



Arrange Icons command (Windows menu)
Use the Arrange Icons to arrange spreadsheet icons in neat vertical and horizontal rows.



Close All command (Windows menu)
Use the Close All command to close all spreadsheet windows. Lucid 3-D prompts you to save any 
changes you have made.

Related Topics
Closing the active window



Hide command (Windows menu)
Use the Hide command to prevent a window from being displayed on the screen. The spreadsheet is still 
open, but is prevented from being shown in window list boxes. Use the Unhide command (Windows 
menu) to display the window.

Related Topics
Hiding and unhiding windows



Unhide command (Windows menu)
Use the Unhide command to make hidden spreadsheet windows visible.

Dialog Box Options
Hidden Windows Select the window to unhide from the

list of hidden windows.
Show Choose the Show button to make the

selected window visible.
Close Exit the dialog box.

Related Topics
Hiding and unhiding windows



Titles command (Windows menu)
Use the Titles command to lock specific rows and columns on the spreadsheet as titles. When you scroll 
the spreadsheet windows, the row and column titles will remain fixed and visible.



List of Windows (Windows menu)
Lucid 3-D displays a list of currently opened spreadsheet windows at the bottom of the Windows menu.

When you choose an open window, you make that spreadsheet active. A check mark appears before the 
active spreadsheet.



More (Windows menu)
When more windows are open than can be displayed on the List of Windows, the More command will 
appear on the Windows menu. When you choose an open window from the list, you make that 
spreadsheet active. The spreadsheet window is moved to the List of Windows and a check mark is placed
before it.



Delete (Edit menu - graph system)
Use the Delete command to delete the active graph.



Refresh (Edit menu - graph system)
Use the Refresh command to recalculate graph values.



Font (Format menu - graph system)
Use the Font command to change the font options for graph elements. You can set the font for titles, axis 
titles, labels, and legends. You have three font choices, small, medium, and large.

Dialog Box Options
Font Style Select the font style for each of the listed graph elements.
Font Size Select the font size for each of the listed graph elements.

Graph Elements (Format menu - graph system)
Use the Graph Elements command to control how the graph appears. You can control the appearance of 
labels and legends, x and y grids.

Dialog Box Options
Transpose Rows and Columns Select this option to switch row and column 

data along with their labels. The default is to
group row data togther for each value. By 
selecting this option, you can group column 
data togther for each value.

Display X Grid Display vertical lines representing points on
the X axis.

Display Y Grid Display horizontal lines representing points 
on the Y axis.

Display Labels Display data labels in the graph.
Display Legends Display legends in the graph. 

Set Titles (Format menu - graph system)
Use the Set Titles command (Format menu - graph system) to add or modify titles on your graph.

Dialog Box Options
Graph Title Type in text for the title of the graph. This text appears at 

the top of the graph.
X Axis Title Type in text for the X Axis title of the graph. This text 

appears at the bottom of the X axis.
Y Axis Title Type in text for the Y Axis title of the graph. This text 

appears to the left of the Y Axis.

Cell right-click menu
Cut

Copy

Paste

Paste Special



Delete

Font

Align

Border

Pattern

Numeric

Auto Function



Auto Function (Cell right-click menu)
AVG (Auto function menu)

MAX (Auto function menu)

MIN (Auto function menu)

NULL (Auto function menu)

PRODUCT (Auto function menu)

STD (Auto function menu)

STDS (Auto function menu)

SUM (Auto function menu)



AVG (Auto Function menu)
Use AVG command (Auto Function menu) to insert the AVG function for the selected range. 

To insert the function
1. Select the range.

2. Click the right mouse button.

3. Choose the Auto Function menu.

4. Select AVG from the Auto Function menu.

5. Point to the cell to insert the function and click the left mouse button.



MAX (Auto Function menu)
Use MAX command (Auto Function menu) to insert the MAX function for the selected range. 

To insert the function
1. Select the range.

2. Click the right mouse button.

3. Choose the Auto Function menu.

4. Select MAX from the Auto Function menu.

5. Point to the cell to insert the function and click the left mouse button.



MIN (Auto Function menu)
Use MIN command (Auto Function menu) to insert the MIN function for the selected range. 

To insert the function
1. Select the range.

2. Click the right mouse button.

3. Choose the Auto Function menu.

4. Select MIN from the Auto Function menu.

5. Point to the cell to insert the function and click the left mouse button.



NULL (Auto Function menu)
Use NULL command (Auto Function menu) to insert the NULL function for the selected range. 

To insert the function
1. Select the range.

2. Click the right mouse button.

3. Choose the Auto Function menu.

4. Select NULL from the Auto Function menu.

5. Point to the cell to insert the function and click the left mouse button.



PRODUCT (Auto Function menu)
Use PRODUCT command (Auto Function menu) to insert the PRODUCT function for the selected range. 

To insert the function
1. Select the range.

2. Click the right mouse button.

3. Choose the Auto Function menu.

4. Select PRODUCT from the Auto Function menu.

5. Point to the cell to insert the function and click the left mouse button.



STD (Auto Function menu)
Use STD command (Auto Function menu) to insert the STD function for the selected range. 

To insert the function
1. Select the range.

2. Click the right mouse button.

3. Choose the Auto Function menu.

4. Select STD from the Auto Function menu.

5. Point to the cell to insert the function and click the left mouse button.



STDS (Auto Function menu)
Use STDS command (Auto Function menu) to insert the STDS function for the selected range. 

To insert the function
1. Select the range.

2. Click the right mouse button.

3. Choose the Auto Function menu.

4. Select STDS from the Auto Function menu.

5. Point to the cell to insert the function and click the left mouse button.



SUM (Auto Function menu)
Use SUM command (Auto Function menu) to insert the SUM function for the selected range. 

To insert the function
1. Select the range.

2. Click the right mouse button.

3. Choose the Auto Function menu.

4. Select SUM from the Auto Function menu.

5. Point to the cell to insert the function and click the left mouse button.



Floating Object right-click menu
Cut
Copy
Paste
Delete
Text
Shadow
Fill
Font
Text Alignment
Color
Border
Drop Shadow Offset



Push Button right-click menu
Cut
Copy
Paste
Delete
Font
Highlight Color
Face Color
Shaded Color
Border Color
Display Text
Text Alignment
Assign Macro
Shadow
Drop Shadow Offset



Cut command (Object right-click menu)
Use the Cut command place the currently selected object into the clipboard. You can use the Paste 
command to place the object on the spreadsheet.



Copy command (Object right-click menu)
Use the Copy command to place the currently selected object into the clipboard. You can use the Paste 
command to place the object on the spreadsheet.



Paste command (Object right-click menu)
Use the Paste command to place the contents of the clipboard at the current selection.



Text command (Object right-click menu)
Use the Text command to toggle the display of text you add to an object. When a checkmark precedes 
this command, any text you added to a floating object will be displayed.



Shadow command (Object right-click menu)
Use the Shadow command to toggle the display of the object's shadow. When a checkmark precedes this
command, a shadow will be added to the floating object. This will give the floating object a three-
dimensional effect.



Fill command (Object right-click menu)
Use the Fill command to toggle the display of a solid fill of the floating object. When a checkmark 
precedes this command, the object will appear solid. When the Fill command is not selected (no 
preceding checkmark), the data in the cells under the floating object will appear through the floating 
object.



Font command (Object right-click menu)
Use the Font command to change the font, style and color of the text in the current selection. 

Dialog Box Options
Font Select the name of the font you want to use or type 

the font name.
Font Style Select a style for the font.
Size Select a size for the font or type in a new size.
Strikeout Select Strikeout if you want lines to appear through 

the font.
Underline Select Underline if you want the font underlined.
Sample Shows a sample of the text using the currently 

selected options.

Text Alignment command (Object right-click menu)
Use the Text Alignment command to position the text of a floating object.    You can position the text 
vertically and horizontally. 

Dialog Box Options
Vertical Select the vertical alignment of the text within the floating 

object.
Horizontal Select the horizontal alignment of the text within the floating

object.

Color (Floating object right-click menu)
Use the Color command to change the background color of a floating object. 

Dialog Box Options
Basic Colors Select the basic color of the background.
Custom Colors Select the custom color of the background.
Define Custom Colors Choose this option to create a new custom 

color.

Border (Object right-click menu)
Use the Border command to add or change the border of the floating object. You can choose the style and
color of the border.

Dialog Box Options
Style Select the style from the available choices.
Line Select the color of the solid portion of the border.
Background Select the color of the fill for border styles that contain dashes 

or dots.



Highlight Color (Push Button right-click menu)
Use the Highlight Color command to change the highlight color of a push button. 

Dialog Box Options
Basic Colors Select the basic color of the highlight.
Custom Colors Select the custom color of the highlight.
Define Custom Colors Choose this option to create a new custom 

color.

Face Color (Push Button right-click menu)
Use the Face Color command to change the face color of a push button. 

Dialog Box Options
Basic Colors Select the basic color of the face.
Custom Colors Select the custom color of the face.
Define Custom Colors Choose this option to create a new custom 

color.

Shaded Color (Push Button right-click menu)
Use the Shaded Color command to change the shaded color of a push button. 

Dialog Box Options
Basic Colors Select the basic color of the shade.
Custom Colors Select the custom color of the shade.
Define Custom Colors Choose this option to create a new custom 

color.

Border Color (Push Button right-click menu)
Use the Border Color command to select the border and its attributes of a floating object or push button. 

Dialog Box Options
Style Select the line style of the border.
Line Select the color of the solid portion of the border.
Background Select the color of the background fill of the 

border.

Display Text (Push Button right-click menu)
Use the Text command to toggle the display of text you add to a floating object. When a checkmark 



precedes this command, any text you added to a floating object will be displayed.



Text Alignment (Push Button right-click menu)
Use the Text Alignment command to position the text of a push button.    You can position the text 
vertically and horizontally. 

Dialog Box Options
Vertical Select the vertical alignment of the text within the push 

button.
Horizontal Select the horizontal alignment of the text within the push 

button.

Assign Macro (Push Button right-click menu)
Use the Assign Macro command to assign a pre-recorded macro to a push button. After assigning a 
macro to a push button, you can play the macro by clicking the push button.

Dialog Box Options
Macro List Select the macro from the list of available macro 

commands.

Shadow (Push Button right-click menu)
Use the Shadow command to toggle the display of the push button's (floating object's)    shadow. When a 
checkmark precedes this command, a shadow will be added to the push button. This will give the push 
button a three-dimensional effect.



Drop Shadow Offset (Push Button right-click menu)
Use the Drop Shadow Offset command to position the shadow of a push button or floating object. The 
number is in a percentage drop from the object.

Dialog Box Options
Vertical Select left/right offset from the object.
Horizontal Select up/down offset from the object.

CASIO Unit Connectivity Setup
Use the Setup dialog to configure communications with your CASIO unit.

Dialog Box Options
Communications Port Select the communications port for the connection.
Baud Rate Select the baud rate for the connection. The baud 

rate must be identical on both computers.
Parity Select the parity setting for the connection. The 

parity must be the same on both computers.
Bit length Select the bit length for the connection. Lucid 3-D 

reverts to 8-bits regardless since Lucid 3-D 
spreadsheets contain binary (8-bit) data. The Bit 
length must be identical on both computers.

Machine Type Select the CASIO machine type for the connection.
Default Choose the Default button to restore the Baud, 

Parity, and Bit Length settings.

Connectivity Packs
Use the Connectivity Packs dialog box to add, remove, or connect to palmtop, handheld and PDA 
computers.

Dialog Box Options
Installed Packs Choose the connectivity pack to 

connect or remove. You don't need 
to select a pack if you are installing a
Connectivity Pack.

Connect Choose Connect to the currently 
selected Connectivity Pack. 

Close Close the Connectivity Packs Dialog 
Box.

Add Choose Add to install a new 
connectivity pack.

Remove Choose Remove to remove the 
currently selected Connectivity Pack.



Advanced Page Setup
Use the Advanced Page Setup dialog box to set properties of the printed page.

Dialog Box Options
Borders Select the borders for cells.
Border Style Select the style of the border line.
Grid Lines Select the grid for the cells.
Grid Style Select the style of the grid lines.
Facing Pages Select this option when you want to print double-

sided pages.
First Page Select the position of the first printed page of the 

facing pages.
Cell Contents Select Results to print the result of a formula, 

select Formula to show the actual formula for the 
cell.

Gutter Margin Specifies the distance to add to the left margin to 
pages when Facing Pages is selected.

Floating Objects Select this option to print Floating Objects on the 
page.

Function Packs
Lucid 3-D for Windows has the ability to add addition built-in functions. The Function Packs dialog box 
allows you to install these Function Packs.

Dialog Box Options
Installed Packs Select the Function Pack from the list for the remove choice.

Add Add new Function Packs to Lucid 3-D for Windows.

Remove Remove the selected Function Pack.



Replace?
Lucid 3-D for Windows is asking you for confirmation on a replace operation.

Dialog Box Options
Replace Replace this instance of the text and continue 

searching.
Replace All Replace this and all other occurences. 

Occurences skipped previously will not be 
replaced.

Skip Skip this occurence and continue seaching.
Cancel Cancel the Find/Replace command.

Scroll to Layer
Use this button to go to a specific layer of the spreadsheet. The layer selected is not activated, only the 
tabs are scrolled. To activate the layer, click on its tab.

Dialog Box Options
Scroll to Layer Select the layer to scroll to.
Set Layer As Select Left-most to make the layer the left most 

tab or Right-most to make the layer the right 
most tab.

Sending....
Lucid 3-D for Windows displays this dialog box during transfers to the Casio unit.



Receiving...
Lucid 3-D for Windows displays this dialog during transfers to the Casio unit.



Add Connectivity Pack
Use the Add Connectivity Pack command to install new Connectivity Packs to 
Lucid 3-D for Windows.

Dialog Box Options
File Name Type the file name and extension of the Connectivity 

Pack to add.
List Files of Type Displays a list of available file types. When you select a 

file type, the File Name list reflects that selection.
Directories Displays a list of available directories. When you select 

a directory, the File Name list reflects that selection.
Drives Displays a list of available drives. When you select a 

drive, the Directories and File Name lists reflect that 
selection.

Add Function Pack
Use the Add Function Pack command to install new Function Pack to Lucid 3-D for Windows.

Dialog Box Options
File Name Type the file name and extension of the function pack to

add.    
List Files of Type Displays a list of available file types. When you select a 

file type, the File Name list reflects that selection.
Directories Displays a list of available directories. When you select 

a directory, the File Name list reflects that selection.
Drives Displays a list of available drives. When you select a 

drive, the Directories and File Name lists reflect that 
selection.

Scroll layer tabs one window right
Use this button to scroll the layer tabs one full window to the right.



Scroll to the left most layer tab
Use this button to scroll the layer tabs to the left most layer.



Scroll to the right most layer tab
Use this button to scroll the layer tabs to the right most layer.



Scroll layer tabs one window left
Use this button to scroll the layer tabs one full window to the left.



Edit Buttons
Click on this button to display the Edit button bar.



Range Buttons
Click on this button to display the Range button bar. You can use these buttons to quickly perform range 
operations on the currently selected range.



Draw Buttons
Click on this button to display the Draw button bar. You can use these buttons to quickly draw floating 
objects (including push buttons) on your spreadsheet.



Embedded Graph Buttons
Click on this button to display the Embedded Graph button bar. You can use these buttons to quickly 
place embedded graphs on your spreadsheet.



Spreadsheet Sizing Button
Click on this button to create a new spreadsheet with a specified number of rows, columns and layers

Dialog Box Options
Layers Specify the number of layers between 1 and 

32000.
Rows Specify the number of rows between 1 and 

32000.
Columns Specify the number of columns between 1 and 

32000.

3D Up Button
Click this button to traverse up one spreadsheet layer. For example, if you are on layer B and click the 3D 
Up Button, Lucid 3-D will move the widebar to the same row and column position on layer A.



3D Down Button
Click this button to traverse down one spreadsheet layer. For example, if you are on layer A and click on 
the 3D Down Button, Lucid 3-D will move the widebar to the same row and column on layer B.



Casio Main Dialog Box
Dialog Box Options

Close Choose the Close button to end the session.
Send Choose the Send button to send a file to the Casio unit.
Receive Choose the Receive button to receive a file from the 

Casio unit.
Setup Choose the Setup button to configure the communication 

to the Casio unit.

 



Macro Options
The Macro Options dialog box allows you to modify the way cell references are treated when macros are 
recorded.

Dialog Box Options
Absolute Rows Select this option to always refer to the same row 

in cell references.
Absolute Columns Select this option to always refer to the same 

column in cell references
Absolute Layers Select this option to always refer to the same layer

in cell references.

Function Packs
The Function Packs dialog box allows you to add Function Packs to Lucid 3-D for Windows.

Dialog Box Options
Installed 
Packs

List of Function Packs installed.

Add Choose this button to add a Function Pack.
Remove Choose this button to remove the Function Pack 

highlighted in the Installed Packs list.

Top Bar
Click on this button to display the main Button Bar.



Left Justification Button
Click this button to left-justify the currently selected cell or range.



Right Justification Button
Click this button to right-justify the currently selected cell or range.



Center Justification Button
Click this button to center-justify the currently selected cell or range.



Bold Button
Click on this button to select or clear bold formatting on the currently selected cell or range.



Italic Button
Click on this button to select or clear italic formatting to the currently selected cell or range.



Font Grow Button
Click on this button to increase the size of the currently selected cell or range font.



Font Shrink Button
Click this button to decrease the size of the currently selected cell or range font.



Audit Notes
Audit Notes displays a list of notes in the active spreadsheet. Select a cell from the list and choose OK to 
move to the cell.



Audit Unreferenced
Audit Unreferenced displays a list of unreferenced cells in the active spreadsheet. An unreferenced cell is 
a value which is not used in any formula in the spreadsheet. Select a cell from the list and choose OK to 
move to the cell.



Audit Formulas
Audit Formulas displays a list of formulas used in the active spreadsheet. Select a cell from the list and 
choose OK to move to the cell.



Audit 3D
Audit 3D displays a list of file links used in the active spreadsheet. Select a cell from the list and choose 
OK to move to the cell.



Audit Dependents
Audit Dependents displays a list of cells whose values are dependent on other cells. Select a cell from the
list and choose OK to move to the cell.



Audit Sources
Audit Sources displays a list of cells on which the current cell value depends on. Select a cell from the list 
and choose OK to move to the cell.



Functions
ABS

ACOS

ACOSH

AND 

ASIN

ASINH 

ATAN

ATAN2

ATANH

AVG

CEILING

CELL

CELLOF

CHAR$

CHOOSE

CLEAN$

CLEANHI$

CLEANLO$

CODE

COL
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CONCAT$

COS

COSH

COUNT

COUNTA

CTERM

DATE

DATEVALUE

DATE$

DAY

DAYOFWEEK

DAYOFWEEK$

DAYS

DAYS360



DAY$

DDB

DEGREES

DLOOKUP

DOLLAR$

ERR

EXACT

EXP

FACT

FALSE

FILEEXISTS

FIND

FIXED$

FLOOR

FV

HEX

HEX$

HLOOKUP

HOUR

HOURS

HYPOT

IF

INDEX

INDEXR

INT

IPMT

IRR

ISBLANK

ISERR

ISERROR

ISLABEL

ISLOGICAL

ISNA

ISNONNUMBER

ISNONSTRING

ISNUMBER

ISRANGE



ISSTRING

JULIAN

JULIANDAY

LAYER

LAYERS

LEFT$

LENGTH

LN

LOG

LOOKUP

LOTTO$

LOWER$

MAX

MEDIAN

MID$

MIN

MINUTE

MINUTES

MIRR

MOD

MONTH

MONTHS30

MONTH$

N

NA

NOT

NOW

NPV

NULL

NUMBER$

OFFSET

OR

PI

PMT

POWER

PPMT

PRODUCT



PROPER$

PV

RADIANS

RAND

RANDOM

RANDOMIZE

RANGE

RANGEOF

RATE

REF

REPEAT$

REPLACE$

RIGHT$

ROUND

ROW

ROWS

S

SEARCH

SECOND

SECONDS

SIGN

SIN

SINH

SLN

SQRT

STD

STDS

SUBST$  SUBST$

SUM

SUMPRODUCT

SYD

TAN

TANH

3DLOOKUP

TERM

TIME

TIME$



TIMEVALUE

TODAY

TRIM$

TRUE

TRUNC

TYPE

UPPER$

VALUE

VAR

VARS

VERSION

VERSION$

VLOOKUP

XOR

YEAR

YEAR$



ABS
ABS(X)

X = a numeric value

ABS returns the absolute value of the expression. The absolute value of any number is the positive value 
of the number regardless of its sign.    ABS(-5) returns 5.

Examples: 
ABS(-9) = 9
ABS(A1-3)
ABS(A3-A2)



ACOS
ACOS(X)

X = a numeric value between -1 and 1

ACOS returns the inverse cosine or arccosine of X. The result represents the angle (in radians) whose 
cosine equals X. The value X cannot be less than -1 or greater than 1. 

Lucid 3-D includes the radians() and degrees() functions to convert between the two angle 
measurements. 

Examples:
ACOS(1/2) = 1.05
ACOS(A4)
ACOS(A3+A2)



ACOSH
ACOSH(X)

X = a numeric value greater than 1

ACOSH returns the inverse hyperbolic cosine, or the hyperbolic arccosine.    The result represents the 
angle (in radians) whose hyperbolic cosine equals X. 

Lucid 3-D includes the radians() and degrees() functions to convert between the two angle 
measurements. 

Examples:
ACOSH(1.5) = .96
ACOSH(A1)



AND
AND(comparison expressions)

comparison expressions =    one or more comparison expressions, separated by commas, that 
evaluate to TRUE or FALSE

AND evaluates the expressions in comparison expressions, and returns TRUE if all the expressions 
evaluate to TRUE. AND returns FALSE if at least one of the comparison expressions evaluate to FALSE.   

Although Lucid 3-D allows you to enter an AND function into a cell, it is most useful in an IF statement to 
determine if two or more conditions are true.    The following statement compares the contents of two cells
and displays a message based on the result of the compare:

IF(AND(A::A1<B::A1,B::A1>C::A1),CONCAT$(" "Higher Sales!"),CONCAT$("High 
Sales!"))
if the contents of the cell B::A1 contains a larger value than the contents of cell A::A1, and it also contains 
a larger value than cell C::A1, this formula prints "Higher Sales".    If either cell C::A1 or cell A::A1 contain 
larger values than cell B::A1, this formula displays "High Sales".

Examples:
AND(TRUE(),TRUE()) = 0.00 (TRUE)
AND(A1,A2)



ASIN
ASIN(X)

X = a numeric value between -1 and 1

ASIN returns the arcsine or inverse sine of X. The result represents the angle (in radians) whose sine 
equals X. 

Lucid 3-D includes the radians() and degrees() functions to convert between the two angle 
measurements. 

Examples:
ASIN(.99) = 1.43
ASIN(B5)



ASINH
ASINH(X)

X = a numeric value

ASINH returns the inverse hyperbolic sine, or the arc-hyperbolic sine. The result represents the angle (in 
radians) whose hyperbolic sine equals X. 

Lucid 3-D includes the radians() and degrees() functions to convert between the two angle 
measurements. 

Examples:
ASINH(.5) = .48
ASINH(A1)



ATAN
ATAN(X)

X = a numeric value 

ATAN returns the arctangent or inverse tangent of X. The result represents the angle (in radians) whose 
tangent equals X.

Lucid 3-D includes the radians() and degrees() functions to convert between the two angle 
measurements. 

Examples:
ATAN(PI()/4) = 0.67
ATAN(A1)



ATAN2
ATAN2(X,Y)

X = a numeric value

Y = a numeric value

ATAN2 returns the arctangent (inverse tangent) of the Y entry divided by the X entry. X is the arccosine 
component. Y is the arcsine component.

Because you specify the sine and cosine portions of the tangent separately, ATAN2 returns values 
between -180 degrees and 180 degrees (PI to PI radians).

ATAN2 returns ERR if X and Y both contain zero.

Lucid 3-D includes the radians() and degrees() functions to convert between the two angle 
measurements. 

Examples:
ATAN2(A1,B1)
ATAN2(PI()/2,PI()/2) = 0.79



ATANH
ATANH(X)

X = a numeric value

ATANH returns the hyperbolic arctangent, the inverse of the hyperbolic tangent.    The result represents 
the angle (in radians) whose hyperbolic tangent equals X.

Lucid 3-D includes the radians() and degrees() functions to convert between the two angle 
measurements.

Examples:
ATANH(-5) = .55
ATANH(A1)



AVG
AVG(list)

list = cells, ranges, or expressions

AVG returns the average of a list of cells, ranges, or expressions.    Lucid 3-D computes average by 
adding the values and dividing by the number of values. AVG returns the SUM of a range divided by the 
COUNT of that range. Lucid 3-D omits labels and empty cells in the computation.

 Examples:
AVG(B10:B20)
AVG(Sales totals)
AVG(January:December)



CEILING
CEILING(X)

X = cell reference

CEILING returns the smallest integer that is not less than the expression. It always rounds up to the next 
integer.

Examples:

CEILING(7.999) = 8
CEILING(7.001) = 8



CELL
CELL(layer,row,column)

layer = a positive integer

row = a positive    integer

column = a positive integer

CELL returns the cell reference for the layer, row, and column. Cell returns ERR if any of the parameters 
contain negative numbers or non-integer values, or if the resulting cell reference is invalid.

Examples:
CELL(1,2,3) = A::C2



CELLOF
CELLOF(range,layer,row,column)

range  = a valid range reference

layer = a positive integer

row = a positive integer

column = a positive integer

CELLOF returns the cell reference for layer, row, and column relative to range. CELLOF returns ERR if 
any of the parameters contain negative or non-integer values; or if the resulting cell reference is invalid or 
outside range.

Examples:
CELLOF(A1..A21,1,2,3) = A::D3



CHAR$
CHAR$(X)

X = an integer between 1 and 255

CHAR$ returns the ASCII character corresponding to X. CHAR$ returns ERR if X contains a non-integer 
value, or a value less than 1 or greater than 255.

Examples:
CHAR$(65) = A
CHAR$(97) = 2



CHOOSE
CHOOSE(index,list)

index = a positive integer less than or equal to the number of                                                                                 
items in List minus one

list = a list of values separated by commas

CHOOSE returns the item in list in the index position. The first item in the list is number 0. CHOOSE 
numbers subsequent items sequentially beginning with 1, 2, 3, and so on.

The index value must be zero or greater, and smaller than the number of items in the list. The list must 
contain at least one item. Each item in the list can be a cell reference, cell name, expression, or a 
combination of these.

Examples:
CHOOSE(A2,C1,C2,C3,C4,C5)
CHOOSE(A1,"FRED","MARTHA","FRANK")



CLEAN$
CLEAN$(string,{validlo,validhi})

string = a valid string value

validlo = a numeric value between 1 and 255 

validhi = a numeric value between 1 and 255

CLEAN$ returns string after removing all non-printable characters from it.

Printable characters are ASCII codes 32 through 127. You can specify the valid low and high characters if 
you desire. You must enter both    high and low values or omit both.

If string is not a valid string value, or you supply an invalid high or low values, CLEAN$ returns ERR.

Examples:
If A1 contains the label 2345Lucid 3-D

CLEAN$ (A1,65,122) = Lucid 3-D



CLEANHI$
CLEANHI$(string)

string = a valid string value

CLEANHI$ returns string after removing all high-order, non-printable characters (ASCII codes 128-255) 
from the string.

Examples:
If cell A1 contains the string "¾ Lucid 3-D"

CLEANHI$ (A1,6) = Lucid 3-D

since ¾ represents the ASCII code 190 symbol



CLEANLO$
CLEANLO$(string)

string = a valid string value

CLEANLO$ returns string after removing all low-order, non-printable characters (ASCII codes 1-31) from 
the string.

Examples:
If cell A1 contains the smiley face character in the string 

Lucid 3-D, 
CLEANLO$(A1) = Lucid 3-D



CODE
CODE(string)

string = a valid string value

CODE returns the ASCII code corresponding to the first character of the string. If the parameter is a null 
string (""), CODE returns 0.

Examples:
CODE ("Lucid 3-D") = 78, the ASCII Code for L



COL
COL(cell or range)

cell = a valid cell reference

range = a valid range reference

COL is a column translator. It accepts a cell reference and returns an integer corresponding to the column
portion of the cell reference. If you supply a range, COL returns the column number of the cell in the top 
left corner of the range.

 Examples:
COL(H1) = 8.00
COL(AA1) = 27.00
COL(IT9999) = 254.00



COLS
COLS(cell or range)

cell = a valid cell reference

range = a valid range reference

COLS returns the number of columns in range.    

Use COLS with a range name to calculate the number of columns in the range. COLS always returns 1 if 
you specify a cell reference as the parameter. COLS(All) returns 255 in a default spreadsheet. All is the 
range of all cells that Lucid 3-D automatically creates in all sheets.

Examples:
COLS(A1:Z1) = 26.00



CONCAT$
CONCAT$(list)

list = valid string values separated by commas

CONCAT$ returns the concatenated form of all strings, joined in the order specified.    All arguments in the
list must be strings or labels, or a cell reference containing a string or label.    If CONCAT$ encounters a 
non-string argument, it returns ERR.

Examples:
CONCAT$(A1,A2,A3) = Welcome to Lucid 3-D!

where 

A1 = "Welcome "

A2 = "to "

A3 = "Lucid 3-D!"



COS
COS(X)

X = a numeric value

COS returns the cosine of X, the relationship of the opposite side of an angle to the hypotenuse. COS 
returns the relationship expressed in radians.

Lucid 3-D includes the radians() and degrees() functions to convert between the two angle 
measurements. 

Examples:
COS(PI()/3) = .50
COS(A3)
COS(A4/A2)



COSH
COSH(X)

X = a numeric value

COSH returns the hyperbolic cosine, the inverse cosine of the angle X (in radians). Lucid 3-D includes the
RADIANS() and DEGREES() functions to convert between the two angle measurements.

Examples:
COSH(PI()/4) = 1.32
COSH(B3)



COUNT
COUNT(list)

list = cells, ranges, or expressions containing values to count

COUNT returns the number of values in the list of ranges, cells, or expressions.

Within ranges, COUNT counts all cells that contain numeric values or formulas, regardless of the results. 
It ignores labels or empty cells.

If you include a cell in the list, Lucid 3-D counts that cell, regardless of its contents. AVG, STD, and VAR 
work the same. You should normally enter single cells as ranges of one cell (A5:A5) instead of as single 
cells (A5).

Examples:
COUNT(A1:A4)
COUNT(A1:A3,A4)



COUNTA
COUNTA(list)

list = cells, ranges, or expressions containing values to count

COUNTA returns the number of cells in a range that contain numbers, labels, or formulas. COUNTA omits
empty cells if they are part of a range, even if the range is only one cell (like A5:A5).    If you list a cell 
individually, such as A5, Lucid 3-D counts it even if it is empty.

 Examples:
COUNTA(A1:A4)
COUNTA(A1:A3,A4)



CTERM
CTERM(rate,future value,present value)

rate = the fixed interest rate per period (expressed as a decimal)

future value = the value the investment will reach

present value = the current value of the investment

CTERM returns the number of compounding periods required to arrive at a future value, from a present 
value, at an interest rate.

Examples:
1. The number of periods for $10,000 to become $100,000 at 10% interest:

CTERM(.1,100000,10000) = 24 (periods)

2. How long will it take to accumulate $50,000 from $20,000 at 12.5%?

CTERM(.125,50000,20000) = 8 (periods)



DATE
DATE(year,month,day)

year = a positive integer between 1 and 9999

month = a positive integer between 1 and 12

day =    a positive integer between 1 and 31

DATE returns the number of days from the beginning of the Anno Domini calendar ( January 3, 0001 A.D. 
= 2 days ) for    year, month, and day. DATE returns ERR if any parameter contains an invalid value, if you
enter a date before January 1, 0001 or after December 31, 9999, or if the date falls between September 
2, 1752 and September 14, 1752.    (These days were removed from the calendar to correct the 
miscalculation of leap years.)

Years in this century must be four digits. Two-digit years represent years in the first century. The month 
must be from 1 to 12, and the day must be equal to or less than the number of days in the month. ERR 
results if you enter invalid dates like the 30th day of February, or a month greater than 12.

DATE returns the calendar date as a date integer or datestamp. Use the Range|Format|Numeric 
command to view these integers in date format. The integer format allows you to subtract two dates to get
the number of days between them, or add a given number of days to a date to discover when a target 
date occurs. You can use the resulting number with most of the calendar functions. 

Examples:
DATE(1966,5,31) = 717853.00
DATE(1976,7,4) = 721540.00
DATE(1995,1,1) = 728295.00



DATEVALUE
DATEVALUE(datestring,formatstring)

datestring = a date as a string, such as 12/31/93

formatstring = specifies the date components in datestring

DATEVALUE returns the datestamp that corresponds to datestring for use in other Lucid 3-D date 
functions.    You can enter datestring as a string value enclosed in double quotations, or use the output 
from the DATE$ command.    

Formatstring contains a series of actions to inform DATEVALUE of the meaning of each character in 
datestring.    To enhance clarity and readability, we recommend that you include a separator in datestring 
and formatstring to separate the month, day, and year components.    A separator can be any non-numeric
character, for example a slash or dash.

DATEVALUE attempts to match each character in datestring with a character or action in formatstring.    
The actions in formatstring have the following effect unless DATEVALUE encounters a separator 
character:

Action Meaning
{Month} 1 or 2 digit numeric month
{Month2} 2 digit numeric month
{MonthName} Full month name
{MonthName3} 3 character month abbreviation
{Date} 1 or 2 digit numeric date
{Date2} 2 digit numeric date
{Year} 4 digit year, 93 translates to 

0093
{Year2} 2 digit year (assumes current 

century)
{Year4} 1993

You must include a character in formatstring for every character in datestring.    If you include a separator 
in datestring, you must include the separator in formatstring between actions.    

If you a omit a date component in datestring, DATEVALUE assumes the date component for the current 
day.    If you omit the month in datestring and formatstring, DATEVALUE assumes the current month.    If 
you omit a component in datestring, and include it in formatstring, DATEVALUE returns ERR.    If you omit
a component in formatstring and include it in datestring, DATEVALUE returns ERR.

Examples:
DATEVALUE("01/01/94","{Month}/{Date}/{Year}")
DATEVALUE("010194","{Month}{Date}{Year}")
DATEVALUE("010194","{Month}{Date}{Year2}")
DATEVALUE("010194","{Month}{Date2}{Year2}")
DATEVALUE("010194","{Month2}{Date2}{Year}")
DATEVALUE("010194","{Month2}{Date2}{Year2}")
DATEVALUE("1/1/94","{Month}/{Date}/{Year}")
DATEVALUE("Jan. 1, 94","{MonthName3}. {Date}, {Year}")



DATEVALUE("Jan. 1, 1994","{MonthName3}. {Date}, {Year4}")
DATEVALUE("January 1, 1994","{MonthName} {Date}, {Year}")



DATE$
DATE$(datestamp,stringtemplate)

datestamp = the integer date result of the DATE, TODAY, or JULIAN functions, or any integer 
between 1 and 3,652,488. It represents the number of days since January 1, 0001.

stringtemplate = any of the template symbols listed below

DATE$ takes a datestamp and returns it as a string in the format you specify. You must enclose format 
string in quotations. See the DATEVALUE function for additional information on formatting dates, 
including the actions that you can include within the brace symbols, {}, and their meaning in the DATE$ 
and DATEVALUE functions.    

DATE$ supports one additional action that you can include within the braces, the {Th} action. The {Th} 
action appends the appropriate characters st, nd, or rd to the day component if date component is a 1, 2, 
or 3 and the first digit in the date is not a 1.    

Examples:
DATE$(DATE(1989,12,30),"{Month2}/{Date2}/{Year2}") = 12/30/89
DATE$(721540,"{MonthName}{Date}, {Year4}") = July 4th, 1776



DAY
DAY(datestamp)

datestamp = the integer date result of the DATE, TODAY, or JULIAN functions, or any integer 
between 1 and 3,652,488. It represents the number of days since January 1, 0001.

DAY returns the day of the month of an integer date. DAY returns an integer from 1 to 31, although some 
months have fewer days.

 Examples:
DAY(31962) = 5
DAY(232867) = 23



DAYOFWEEK
DAYOFWEEK(datestamp)

datestamp = the integer date result of the DATE, TODAY, or JULIAN functions, or any integer 
between 1 and 3,652,488. It represents the number of days since January 1, 0001.

DAYOFWEEK returns the number that represents the day of the week for datestamp. Sunday is 1, and 
Saturday is 7. datestamp must contain the number of days from the start of the Anno Domini calendar. 
DAYOFWEEK returns ERR if datestamp is out of range.

Examples:
DAYOFWEEK$(717855) = 5
DAYOFWEEK$(DATE(1994,1,1) = 7
DAYOFWEEK$(C7) 



DAYOFWEEK$
DAYOFWEEK$(datestamp)

datestamp = the integer date result of the DATE, TODAY, or JULIAN functions, or any integer 
between 1 and 3,652,488. It represents the number of days since January 1, 0001.

DAYOFWEEK$ returns the string that represents the day of the week for datestamp. The datestamp must
be the number of days from the start of the AD calendar

Examples:
DAYOFWEEK(717855) = Thursday
DAYOFWEEK(DATE(1994,1,1) = Saturday
DAYOFWEEK(C7) 



DAYS
DAYS(datestamp,datestamp)

datestamp = the integer date result of the DATE, TODAY, or JULIAN functions, or any integer 
between 1 and 3,652,488. It represents the number of days since January 1, 0001.

DAYS returns the number of days between the first and second datestamp. 

Examples:
DAYS(232867,232502) = 365
DAYS(DATE(1993,7,22),DATE(1966,5,31)) = 9914
DAYS(A1,A2)



DAYS360
DAYS360(datestamp,datestamp)

datestamp = the integer date result of the DATE, TODAY, or JULIAN functions, or any integer 
between 1 and 3,652,488. It represents the number of days since January 1, 0001.

DAYS360 returns the number of days between the first and second datestamp based on a 360-day year 
(30-day month). ERR results if either parameter is not a valid datestamp or if either datestamp represents 
a date whose day is the 31st day of the month.

Examples:

DAYS360(232867,232502) = 360
DAYS360(today(),date(1995,1,1))
DAYS360(B5)



DAY$
DAY$(datestamp)

datestamp = the integer date result of the DATE, TODAY, or JULIAN functions, or any integer 
between 1 and 3,652,488. It represents the number of days since January 1, 0001.

DAY$ returns the ordinal day of the month, between 1st and 31st, for the date in datestamp, as a string.    
The datestamp must be the number of days from the start of the Anno Domini calendar.    DAY$ returns 
ERR if the supplied datestamp is out of range.

Examples:

DAY$(232867) = 23rd
DAY$(DATE(1993,10,31) = 31st
DAY$(A4)



DDB
DDB(cost,salvage,life,period)

cost = the asset's purchase price

salvage = the expected value of the asset at the end of its useful life

life = the number of periods that the asset is useful

period = the period of depreciation

DDB stands for the double declining balance method of depreciation and calculates the depreciation 
amount on a capital asset in a given period. The double declining balance method gives large 
depreciation amounts in the beginning periods and smaller amounts near the end of the asset's useful 
life.

Examples:
1. Depreciation for first year, $500,000 purchase price, $50,000 salvage value after 5 years:

DDB(500000,50000,5,1) = $200,000

2. The salvage value in the third year:

DDB(500000,50000,5,3) = $72,000



DEGREES
DEGREES(radians)

radians = numeric value 

degrees converts the angle represented as radians to the angle representation in degrees.    A circle 
consists of 360 degrees, or 2 PI radians. Lucid 3-D includes the RADIANS() function to convert from 
degrees to radians.

Examples:
DEGREES (.5) = 30
DEGREES (1.57) = 90
DEGREES (2*PI()) = 360



DLOOKUP
DLOOKUP(range, condition, key, rowoffset, columnoffset)

range = a valid range reference

condition = a comparison operator enclosed in double quotations

key = a string or numeric value or a cell reference

rowoffset = a positive integer

columnoffset = a positive integer

DLOOKUP is a one dimensional table lookup function.    It searches for key in the cell in the upper left 
corner of all layers in range, based on condition.    

You can specify a string or numeric value for key, or a cell reference containing a string or numeric value. 
You may include any of the following comparison operators for condition: "<", "<=", "=", ">=", or ">".

Rowoffset and columnoffset define the row and column of the cell DLOOKUP returns.    When DLOOKUP 
locates a cell containing key that satisfies condition, DLOOKUP returns the contents of the cell that is 
rowoffset rows below and columnoffset columns to the right of the cell that satisfies the condition.

DLOOKUP skips empty cells and cells that contain a different data type than key.    DLOOKUP returns 
ERR if it fails to locate a cell that satisfies key and condition, if rowoffset or columnoffset contain negative 
or non-numeric values, or if rowoffset or columnoffset generate a cell reference outside of range.

Examples:
DLOOKUP(A::A1:G::E10, "<", 100, 1, 3 )

Searches the cells in A::A1 through G::A1, for a value less than 100.    When it locates a value less than 
100, it returns the contents of the cell one row below and three columns to the right of the cell that 
contains the value.    For example, if DLOOKUP locates the value 98 in the cell B::A1, it returns the value 
in the cell at layer B, row 4, column D.    

DLOOKUP(B::B2:M::L10, "<", 0, 0,1)
Searches the cells in B::B2..M::B2 for negative values and returns the contents of the cell immediately to 
the right of it. 



DOLLAR$
DOLLAR$(X{,decimals})

X = a numeric value

DOLLAR$ converts the value in X to a string and inserts a decimal point, commas, and a dollar sign to 
format X as a monetary value.    If decimals contains a positive integer, DOLLAR$ rounds X to contain 
decimals digits to the right of the decimal point.    If decimals contains a negative integer, DOLLAR$ 
rounds decimals digits to the left of the decimal point to zero.    If you omit decimals, DOLLAR$ assumes a
value of 2 and rounds X to 2 places to the right of the decimal point.

DOLLAR$ returns an error if decimals does not contain an integer value, or if decimals contains a value 
outside the range -20 to 20. 

Examples:
DOLLAR$(1234.5678,2) = $1,234.57
DOLLAR$(1234.5678,-2) = $1,200.00
DOLLAR$(A2,2)



ERR
ERR( )
Any formula that results in an error shows ERR in the cell. Entering ERR into a cell explicitly produces an 
error condition. You can also cause it deliberately by entering a formula such as 1/0.

ERR has no numeric value. When a formula in the sheet refers to a cell with ERR, Lucid 3-D passes the 
ERR on to become the result of that formula.



EXACT
EXACT(string1,string2)

string1 = a valid text string 

string2 = a valid text string 

EXACT compares two string values for an exact match, including the case of letters. Exact returns ERR if 
either cell contains numeric values.

Examples:
EXACT("THIS","THAT") returns 0
EXACT("THIS","THIS") returns -1
EXACT(A1,A2)



EXP
EXP(X)

X = a numeric value

EXP returns the value of e raised to the Xth power. e is a constant used in scientific formulas and equals 
2.7182818284591 in Lucid 3-D. e is also the base used in natural logarithms (LN function). EXP is the 
inverse of the LN function.

EXP(1) generates the value e for use in calculations, since any number raised to the power 1 is the 
number itself.

Examples: 

EXP(1)
EXP(B4)
EXP(A1-A2*A3)



FACT
FACT(X)

X = a numeric value

FACT returns the product of all integers from 1 to X.

Examples:
FACT(4) = 24, the product 4*3*2*1
FACT(A8)



FALSE
FALSE( )
FALSE is a logical function that always equals 0.00 in Lucid 3-D. FALSE does not require a parameter, 
but requires parentheses.



FILEEXISTS
FILEEXISTS(string)

string = a valid string value

FILEEXISTS returns TRUE (-1.00) if the string is a unique file that exists, or FALSE (0.00) if the file does 
not exist. Lucid 3-D searches only the current directory unless you specify a complete path name.

Examples:
FILEEXISTS("sheet1.lcw")
FILEEXISTS(A1)
FILEEXISTS("c:\autoexec.bat")



FIND
FIND(substring,searchstring,offset)

substring = the substring to find

searchstring = the string to search

offset = the character position where the search begins

FIND compares two cells containing strings and determines the position of substring within searchstring. 
The search begins at offset and continues to the end of the string. FIND returns ERR if it fails to locate the
string.

Offset lets you start the search a specified number of characters into the search string. To search the 
entire string, use an offset of 1.

You may specify control characters in the substring by prefixing the control character letter with the tilde 
character (~). To search for Control J, enter "~J". To find an actual tilde character, use "~~".    

FIND returns ERR if it fails to find a match, if substring is a null string (""), or if the offset is less than 1.    

Note: FIND performs a case-sensitive search.

Exercise
1. In cell A1, enter:

Amalgamated Gadgets Incorporated
2. In cell A2, enter: Inc
3. Enter in cell A3:

FIND(A2,A1,0)
FIND returns 21.00, because the label "Inc" was found in cell A1 in the 20th position.

4. Now change A2 to "ted". The new result is 9.00, because that string is found (first) in the 9th 
position.

5. Now edit the FIND formula to read:

FIND(A2,A1,10)
6. The new result is 30.00 because FIND started after the first occurrence of "ted" and found the 

second occurrence in position 29.



FIXED$
FIXED$(X{,decimals})

X = a numeric value

decimals = an integer value in the range -20 to 20

FIXED$ converts the value in X to a string and inserts a decimal point and commas.    If decimals contains
a positive integer, FIXED$ rounds X to contain decimals digits to the right of the decimal point.    If 
decimals contains a negative integer, FIXED$ rounds decimals digits to the left of the decimal point to 
zero. If you omit decimals, FIXED$ assumes 0 and returns an integer.

FIXED$ returns an error if decimals contains a value outside the range    -20 to 20, or a non-integer value.

Examples:
FIXED$(1234.5678, 2) = 1,234.57
FIXED$(1234.5678,-2) = 1,200.00
FIXED$(A2,2)



FLOOR
FLOOR(X)

X = a numeric value

FLOOR returns the largest integer not greater than the expression. It always rounds down to the nearest 
integer.

Examples:
FLOOR(5.001) = 5
FLOOR(5.999) = 5



FV
FV(payment,rate,term)

payment =    the amount    paid each period

rate = the interest rate charged per period (expressed as a decimal)

term = the number of payments

Note: Rate is the interest rate per period not the more familiar A.P.R. (Annual Percentage Rate). To 
determine the rate, divide the APR by the number of periods per year. For instance, enter 8% APR    
as .08/12, for monthly payments.

FV returns the future value of a set of equal cash flows, assuming a constant interest rate and equally 
spaced payments. It is based on the following formula:

FV = payment*((1 + rate)^term - 1)/rate 

Examples:
1. Monthly payments of $250, at 10% APR, for 5 years (60 months) would be:

FV(250,.10/12,60) = $19,359.27



HEX
HEX(string)

string = a valid string 

HEX returns the value of an unsigned case-insensitive hexadecimal string (of up to 32 bits of precision). It
returns ERR if the argument is not a string, if the hexadecimal string is null ("") or contains more than 8 
characters, or if the string contains a non-hexadecimal digit. Valid hexadecimal digits are 0-9 and A-F.

Examples:
HEX("FFFF") = 65535
HEX(A1)



HEX$
HEX$(X)

X = a numeric value

HEX$ returns the ASCII hexadecimal string representation of X.

HEX$ returns ERR if X is not numeric, if X contains a value too large to fit in a 32-bit unsigned integer, of 
if X is negative.

Examples:
HEX$(65535) = FFFF



HLOOKUP
HLOOKUP(range, condition, key, layeroffset, rowoffset)

range = a valid range reference

condition = a comparison operator

key = a numeric value or string

layeroffset = a positive integer

rowoffset = a positive integer

HLOOKUP is a one dimensional, horizontal table lookup function.    It searches for key in the uppermost 
row in range, based on condition.    

You can specify a string or numeric value for key, or a cell reference containing a string or numeric value. 
You may include any of the following comparison operators for condition: "<", "<=", "=", ">=", or ">".

Layeroffset and rowoffset define the layer and row of the cell HLOOKUP returns.    When HLOOKUP 
locates a cell containing key that satisfies condition, HLOOKUP returns the contents of the cell that is 
layeroffset layers deeper and rowoffset rows below the cell that satisfies the condition.    

HLOOKUP skips empty cells and cells that contain a different data type than key.    HLOOKUP returns 
ERR if it fails to locate a cell that satisfies key and condition, if layeroffset or rowoffset contain negative or 
non-numeric values, or if layeroffset or rowoffset generate a cell reference outside of range.

Examples:
HLOOKUP(A::A1:D::E10, "<", 100, 1, 2 )
Searches the cells in row 1 of layer A in columns A through E for a value less than 100.    When it locates 
a value less than 100, it returns the contents of the cell one layer deeper and two rows to the right of the 
cell that contains the value.    For example, if HLOOKUP locates the value 98 in the cell in layer A, row 1, 
column A, it returns the value in the cell at layer B, row 1, column C.

HLOOKUP(B::B2:E::L10, "<", 0, 0,1)
Searches row 2 of layer B in columns B through E for negative values and returns the contents of the cell 
immediately to the right of it. 



HOUR
HOUR(timestamp)

timestamp = a positive integer less than 86,400, representing the number of elapsed seconds. Use 
TIME or NOW functions to produce timestamp or enter it directly as a number.

HOUR returns the hours component of timestamp. Lucid 3-D expresses time values as the number of 
seconds since midnight. HOUR returns ERR if timestamp contains a negative number or a value larger 
than or equal to 86,400.    

Examples:
HOUR(NOW) = current hour
HOUR(TIME(3,15,30)) = 3
HOUR(44857) = 12 (the noon hour)
HOUR(A1) = hour of cell A1



HOURS
HOURS(timestamp,timestamp)

timestamp = a positive integer less than 86,400 representing the number of elapsed seconds.    Use 
the TIME or NOW functions to produce timestamp or enter it directly as a number.

HOURS returns the number of hours between the second and first timestamps.    HOURS returns an error
if either timestamp contains a negative number or a value larger than or equal to 86,400.    

Examples:
HOURS(10500,3600) = 2
HOURS(3606,10800) = -2
HOURS(TIME(3,15,30),TIME(4,56,24)) = -1.68



HYPOT
HYPOT(length1,length2)

length1 and length2 = numeric values

HYPOT returns the length of the hypotenuse of a right triangle whose sides are length1 and length2. The 
length of the hypotenuse squared equals the sum of the square of its sides. HYPOT returns ERR if 
length1 and length2 contain non-numeric values or negative numbers.

The following example returns 5 because 32, which is 9, plus 42, which is 16, equals 52, which is 25.

Examples:
HYPOT(3,4) = 5
HYPOT(1,2) = 2.24
HYPOT(A1,B1)



IF
IF(comparison,true result,false result)

comparison = an expression that evaluates to TRUE or FALSE 

true result = a number or string to return if the comparison is true

false result = a number or string to return if the comparison is false

IF returns one of two values, true result or false result, based on the results of a logical comparison. Lucid
3-D returns a FALSE result as 0.00, and a TRUE result as -1.00. 

Lucid 3-D returns ERR if the result of the comparison is non-numeric, or if the return expressions are not 
string or numeric values.

Comparison expressions are written using one or more of the following operators:

= Equal to

< Less than

<= Less than or equal

> Greater than

>= Greater than or equal

<> Not equal

& Bitwise AND

¦ Bitwise OR

^ Bitwise XOR 

~ Bitwise NOT

Examples of valid comparison expressions using actual numbers: 

1=1 (TRUE) -1.00

1>=2 (FALSE) 0.00

1>2 (FALSE) 0.00

2< >2 (FALSE) 0.00

The last example is FALSE because < > means not equal and 2 equals 2. If you enter any of these 
examples directly into a cell, -1.00 or 0.00    shows for TRUE or FALSE.

These examples use cell references in their comparisons:

A1>A2
B1=B2
C3<>C2
D1=>D3
D3>4
E1=10

These formulas would show -1.00 (TRUE) or 0.00 (FALSE) depending on the contents of the cells shown.

Using Labels with Comparison Functions
We entered the results Yes and No into cells and referred to those cells in the IF formulas. You could also 



enter labels as part of the formula like:

IF(A1<A2,"Yes","No")
Using Values in Comparisons
Because 0.00 is FALSE and any non-zero value is TRUE, you can use other expressions instead of 
expressions using comparison operators.

For example, the formula:

IF(A1,A4,A5)
returns the contents of cell A4 if cell A1 contains a non-zero value, or A5 if cell A1 contains a numeric 
value of 0, or is empty. Try entering this formula, and go to cell A1 and enter various numbers to see what 
Lucid 3-D    treats as true.



INDEX
INDEX(layer,row,column)

layer = a positive integer

row = a positive integer

column = a positive integer

INDEX returns the value of the cell whose cell reference is defined by layer, row, and column. It returns 
error if any of the arguments are not positive integers, or if the cell reference is invalid.

Examples:
INDEX(2,2,2) = the contents of cell B::B2
INDEX(A1,A1,A1)



INDEXR
INDEXR(range,layer,row,column)

range = a valid range reference

layer = a positive integer

row = a positive integer

column = a positive integer

INDEXR returns the value of the cell whose cell reference is defined by layer, row, and column, relative to
the range. In contrast to INDEX, layer, row, and column act as offset values from the upper left corner of 
the range. INDEX counts the first layer, row, and column in the spreadsheet as 1. INDEXR treats the 
upper-left corner of the range as layer 0, row 0, column 0. 

INDEXR returns ERR if any of the offset parameters are not positive integers, or if the cell reference is 
invalid or does not remain within the range.

Examples:
INDEXR(B::B2:E::E5,3,3,3) = the contents of cell E:E5
INDEXR(D:D7::Z:Z39,0,0,0) = the contents of cell D:D7



INT
INT(X)

X = a numeric value

INT returns the integer value of X. To obtain integer value, INT truncates the fractional part of the number.

INT does not round values, it discards the fractional part of the value entirely, so INT(7.99) evaluates as 7.
See ROUND if you need to round numbers instead of truncating.

 Examples:
INT(A4)
INT(A4/2)



IPMT
IPMT(principle,rate,term,periodnumber)

principal = a positive numeric value representing the amount of the loan

rate = interest rate per period expressed as a decimal

term = a positive integer representing the number of payments 

periodnumber = a positve integer identifying the payment number of term

IPMT returns the interest portion of a loan payment for a certain period number in the term of the loan.    
IPMT calculates the interest based on the principle borrowed for term amount of time, at an interest rate 
of rate.    IPMT assumes that rate contains a constant annual interest rate and the number of periods in 
term are equally spaced throughout term.    

IPMT calculates the amount of interest included in a loan payment for a certain payment number.    For 
example, to determine the amount of interest contained in payment number 3 of a $15,000 loan at 8% 
interest for 60 months, use the following formula:

IPMT(15000,.08/12, 60,3)
IPMT returns ERR if any of the parameters contain non-numeric values. See the PPMT function to 
calculate the amount of principle payment contained in a loan payment, and the PMT function to calculate
the total amount of a payment.    PMT calculates the amount of payment on a loan at an interest rate, 
IPMT calulates the amount of interest contained in the payment, and PPMT calculates the amount of 
principle.    

Note: Due to rounding, the amount that PPMT and IPMT return may not total exactly to the amount PMT 
returns. 

Examples:
1.    What monthly payment is required to repay $20,000 at 7% interest for 48 months? 

How much interest does the 13th payment include and how much principle does it include?

PMT(20000,.07/12,48) = 478.92 (the amount of payment)

PPMT(20000,.07/12,48,13) = 471.95 (the amount of principle in the 13th payment)

IPMT(20000,.07/12,48,13) = 6.98 (the amount of    interest in the 13th payment)

2.  IPMT(A1,B1/12,C1,D1) computes the amount of interest on the principle in cell A1 at the
interest rate in B1, for the term in C1, for the payment number in D1.



IRR
IRR(range,guess)

range = a valid range reference representing the range of cash flow amounts comprising the 
investment

guess = a numeric value

IRR computes the internal rate of return or the interest rate that makes the net present value (NPV) of an 
investment equal to zero. Like NPV, you can use the internal rate of return to evaluate the relative 
attractiveness of investment opportunities.

You compute an IRR by trial and error (iteration), using the guess interest rate as the starting point. 
Guess estimates the internal rate of return on the investment represented by range. If you have no idea 
what this number might be, start with zero. A value between 0 and 1 usually gives a good answer. If you 
fail to find an answer after 20 tries, an error results. An answer is found if the difference between two 
iterations is less than 1.0E-7.

In the range, the first entry should be negative, indicating the initial outlay. The following entries are the 
cash flows made at regular intervals. If there are some negative entries in the cash flows, IRR can return 
more than one answer depending on the guess interest rate. See MIRR for cash flows that change in 
sign. IRR treats blank cells as zero.



ISBLANK
ISBLANK(cell or range)
ISBLANK returns TRUE (-1.00) if cell is empty, or if range contains all empty cells. ISBLANK returns 
FALSE (0.00) if cell contains a string, label, or number; or if range contains values in any cell. ISBLANK 
returns ERR if you specify an invalid cell or an invalid range reference.

Examples:
ISBLANK(A1) = -1.00 if cell A1 is empty, 0.00 if cell A1contains a number, string, or label

ISBLANK(A1..D4) = 0.00 if any cell in the range A1through D4 contains a number, string, or label, -
1.00 if all of    cells in the range A1 through D4 are empty



ISERR
ISERR(cells or ranges)
ISERR tests the given cell (or cells) for an error condition. If Lucid 3-D finds ERR, it returns the value 
TRUE, otherwise it returns FALSE. TRUE equates to -1.00 and FALSE equates to 0.00.

ERR can result from a mistyped formula, missing or incorrect data, an attempt to divide by 0, or other 
unintentional error, or the result of intentionally entering ERR into a cell. ISERR traps an error condition to
prevent it from flowing throughout your entire sheet.

Any formula that contains or depends on a value of ERR yields a result of ERR. The formula 
IF(A1=ERR(),A2,A3) always results in ERR. To return A2 or A3, use the    formula:

IF(ISERR(A1),A2,A3)
Examples:

ISERR(C1)
ISERR(C1:D5)
ISERR(C1,C2,H3)
ISERR(C1:C10,E4,E5)



ISERROR
ISERROR(cells or ranges)
ISERROR returns TRUE if any cell in the list contains an error or NA reference. If all cells equate to 
anything else, ISERROR returns FALSE. TRUE equates to -1.00 and FALSE equates 0.00.

Examples:
ISERROR(C1)
ISERROR(C1:D5)
ISERROR(C1,C2,H3)
ISERROR(C1:C10,E4,E5)



ISLABEL
ISLABEL(cells or ranges)
ISLABEL returns TRUE if it finds a label reference in any of the cells in the list. If no labels appear in the 
cells, ISLABEL returns FALSE. TRUE equates to -1.00 and FALSE equate to 0.00.

Examples:
ISLABEL(C1)
ISLABEL(C1:D5)
ISLABEL(C1,C2,H3)
ISLABEL(C1:C10,E4,E5)



ISLOGICAL
ISLOGICAL(cells or ranges )
ISLOGICAL returns TRUE if any of the cells in the list contain -1.00 (TRUE), or 0.00 (FALSE).    
ISLOGICAL returns FALSE if any cell in the list contains nonumeric values or numeric values other than 0
or -1.

Examples:
ISLOGICAL(C1)
ISLOGICAL(C1:D5)
ISLOGICAL(C1,C2,H3)
ISLOGICAL(C1:C10,E4,E5)



ISNA
ISNA(cells or ranges)
ISNA examines the cells and returns TRUE if any cell contains the entry NA. Otherwise, it returns FALSE.
TRUE equates to -1.00 and FALSE equates to 0.00. ISNA corresponds to NA in much the same way 
ISERR corresponds to ERR.

Examples:
ISNA(C1)
ISNA(C1:D5)
ISNA(C1,C2,H3)
ISNA(C1:C10,E4,E5)



ISNONNUMBER
ISNONNUMBER(cells or ranges)
ISNONNUMBER returns TRUE (-1.00) if any cell in the list contains a nonumeric value, including a string,
label, cell, or range reference. If any cells contain numbers, ISNONNUMBER returns FALSE (0.00).

Examples:
ISNONNUMBER(C1)
ISNONNUMBER(C1:D5)
ISNONNUMBER(C1,C2,H3)
ISNONNUMBER(C1:C10,E4,E5)



ISNONSTRING
ISNONSTRING(cells or ranges)
ISNONSTRING returns TRUE (-1.00) if any cell in the list contains a number, label, cell, or range 
reference.    If all cells contain string values, ISNONSTRING returns FALSE (0.00).

Examples:
ISNONSTRING(C1)
ISNONSTRING(C1:D5)
ISNONSTRING(C1,C2,H3)
ISNONSTRING(C1:C10,E4,E5)



ISNUMBER
ISNUMBER(cells or ranges)
ISNUMBER returns TRUE (-1.00) if any cell in its list contains a number.    ISNUMBER returns FALSE 
(0.00) if all cells contain a label, string value, cell, or range reference.

You can use ISNUMBER in an IF function. 

For example:

IF(ISNUMBER(A1),A1,0)
returns 0.00 if cell A1 contains a label, and the number in cell A1 if    A1 contains a number.

Exercise
1. Enter in cell A1:

14
2. Enter in cell A2:

ISNUMBER(A1)
3. The result is -1.00. Now enter in cell A1 the label "Text" and the formula results in 0.00.



ISRANGE
ISRANGE(cells or ranges)
ISRANGE returns TRUE (-1.00) if any argument in its list contains a range reference.    If none of the 
arguments contain a range reference, ISRANGE returns FALSE (0.00).

Examples:
ISRANGE(C1)
ISRANGE(C1:D5)
ISRANGE(C1,C2,H3)
ISRANGE(C1:C10,E4,E5)



ISSTRING
ISSTRING(cells or ranges)
ISSTRING returns TRUE (-1.00) if any cell in its list contains a string.    If all cells contain labels or 
numbers, ISSTRING returns FALSE (0.00).    

Exercise
1. Enter in cell A2:

ISSTRING(A1)
2. Enter in cell A1 a label, like "April".    A2 contains -1. 00.

3. Now change cell A1 to a number.    A2 contains 0.00.



JULIAN
JULIAN(year, julianday)

year = a four digit integer between 0001 and 9999

julianday = an integer between 1 and 365

JULIAN returns the number of days from the beginning of the Anno Domini calendar (i.e. January 3, 0001 
A.D. = 2 days) for year and julianday. The julianday represents the number of days since December 31 of 
the previous year. For example, February 1 in any year is day 32. 

JULIAN returns ERR if the date falls between September 2, 1752 and September 14, 1752. These days 
were deleted from the calendar to adjust for miscalculated leap years.

Examples:
JULIAN(1993,203) = 727767
JULIAN(1776,185) = 648491



JULIANDAY
JULIANDAY(datestamp)

datestamp = the integer date result of the DATE, TODAY, or JULIAN functions or any integer between
1 and 3,652,488. It represents the number of days since January 1, 0001.

JULIANDAY returns the Julian day of the year, between 1 and 366, for the date specified by datestamp. 
You must express datestamp as the number of days from the start of the Anna Domini calendar. 
JULIANDAY returns ERR if    datestamp is out of range.

Examples:
JULIAN(123547) = 94
JULIAN(DATE(76,7,4)) = 186
JULIAN(C5)



LAYER
LAYER(cell or range)
LAYER returns the numerical value for the layer of cell. If you include range, LAYER returns the layer for 
the top left corner of range.

Examples:
LAYER(E5) 
LAYER(C9:D7)
LAYER(EXPENSES::C5)



LAYERS
LAYERS(cell or range)
LAYERS returns the number of layers in range. LAYERS always returns 1 if the argument is a cell 
reference.

Examples:
LAYERS(A::A1:Z::A1) = 26
LAYERS(PARKING::C5:TOTALS::F10)



LEFT$
LEFT$(string,count)

string = a valid string

count = a positive integer

LEFT$ returns a substring of string. Count specifies the number of characters to return. LEFT$ returns 
count characters of string, beginning with the first character in string.    If count is greater than the length 
of a string, LEFT$ returns the entire contents of string.    LEFT$ returns ERR if count contains a negative 
number or non-integer value.

Examples:
LEFT$("LUCIDITY",5) = LUCID
LEFT$(A2,7)



LENGTH
LENGTH(string)

string = a valid string

LENGTH returns the number of characters in string. You can include a cell reference or an expression 
that results in a label. LENGTH returns ERR if string contains a number. 

Exercise
1. In cell A1, enter:

Lucid 3-D for Windows
2. In cell A2, enter:

LENGTH(A1) = 21.00, because there are 21 characters (including the spaces) in the label Lucid 
3-D for Windows.



LN
LN(X)

X = a positive numeric value 

LN returns the natural logarithm of X, Loge(X). Natural logs use base e. e is a constant equal to 
2.7182818284591 in Lucid 3-D. 

In mathematics, LN is the inversion function of the EXP function. LN(EXP(X)) always equals X and    
EXP(LN(X)) always equals X.

LN returns ERR if X is negative.

Examples: 
LN(2.7182818) = 1
LN(A3)
LN(A4*A3)



LOG
LOG(X)

X = a positive numeric value

LOG returns the common logarithm of X, or Log10 (log base 10) of X. LOG returns ERR, if X contains a 
negative number.

Examples:
LOG(100) = 2.00
LOG(A4)
LOG(A4*3)



LOOKUP
LOOKUP(range, rowcondition, rowkey, columncondition, columnkey) 

range = a valid range reference from a single layer

rowcondition = a comparison operator enclosed in quotes

rowkey =    a string or numeric value or a cell reference to either

columncondition = a comparison operator enclosed in quotes

columnkey = a string or numeric value or a cell reference to either

LOOKUP is a two-dimensional table lookup function that searches the current layer of the spreadsheet. 

LOOKUP searches the leftmost column of top layer in range for a cell that satisfies rowkey and 
rowcondition. 

After it finds rowkey, it searches the top row in the layer for the cell that satsifies columnkey and 
columncondition.

If LOOKUP locates cells in both searches, it returns the value of the cell at the intersection of the two cells
that satisfy the keys and conditions.

You can specify a string or numeric value for key, or a cell reference containing a string or numeric value. 
You may include any of the following comparison operators for condition: "<", "<=", "=", ">=", or ">".

LOOKUP skips empty cells and cells that contain a different data type than key.    LOOKUP returns ERR if
it fails to locate a cell that satisfies key and condition, if rowoffset or columnoffset contain negative or non-
numeric values, or if rowoffset or columnoffset generate a cell reference outside of range.

Examples:
LOOKUP(B6:D10,">",5,"=",10)

Searches column B for a value greater than 5. When it finds it, it looks across row 6 for the value 
10. It returns the contents of the cell at the intersection of the two cells.



LOTTO$
LOTTO$(count,maximum)

count = an integer between 1 and 10 

maximum = an integer between 1 and 100

LOTTO$ returns a string containing a series of non-repeating random integers.    Count specifies the 
number of integers to return and maximum specifies the highest number allowable in the "draw". 
Maximum must exceed count.

Examples:
LOTTO$(5,50)

returns 5 random numbers between 1 and 50



LOWER$
LOWER$(string)

string = a valid string

LOWER$ returns the string with all uppercase letters in string converted to lower case. LOWER$ does not
change numbers embedded in string. LOWER$ returns ERR if string does not contain a string value.

Examples:
LOWER$("Lucid 3-D for Windows") = lucid 3-d for windows
LOWER$(A12)



MAX
MAX(list)

list = cells, ranges, or expressions 

MAX returns the largest value in its list of cells, ranges, and expressions. 

MAX accepts several types of data in its parentheses. It can take a list of expressions, constants, cell 
references, or range designations. Separate each cell reference or range designation by commas in the 
list. You can also use cell or range names in the list, or actual numbers. You can mix expressions 
combining cells, operators, and numbers. MAX ignores empty cells and cells with labels or string values.

Examples:
MAX(100,279,310,261,250-2) = 310.00



MEDIAN
MEDIAN(list)

list = cells, ranges, or expressions 

MEDIAN returns the middle value in the list of cells. There are an equal number of values in the list that 
are larger and smaller than the value MEDIAN returns. If there are an odd number of values, MEDIAN 
always returns a value in the list. If there are an even number of values, MEDIAN returns a number 
halfway between the two center-most values in the list. 

For example, MEDIAN (2,4,5) returns 4. MEDIAN (2,3,4,6) returns 3.5, the number halfway between 3 
and 4, the two center-most values in the list.    To demonstrate the difference between the AVERAGE 
function and the MEDIAN function, some of the following examples include the AVERAGE function.

Examples:
MEDIAN(2,3,4,6) = 3.5
AVERAGE(2,3,4,6) = 3.75
MEDIAN(1,2,4,5,8) = 4
AVERAGE(1,2,4,5,8) = 5
MEDIAN(C1..C10)



MID$
MID$(string,column {,length})

string = a valid string

column = a positive integer

length = a positive integer

MID$ returns a substring of string beginning with the specified column, for an optional count of length 
characters. If you omit length, MID$ returns the remainder of string.    If column is larger than the number 
of characters in string, MID$ returns a null string ("").    If the value of column plus length exceeds the 
number of characters in string, MID$ returns the remainder of string beginning at column.

Examples:
MID$("Welcome to Lucid 3-D for Windows",12,9)
= "Lucid 3-D", 9 characters beginning with the 12th    character

MID$("Welcome to Lucid 3-D for Windows",12)
= "Lucid 3-D for Windows", the remainder of the string    beginning with the 12th character.

MID$(A1,4,5) = five characters of the string in cell A1 starting at the fourth character.



MIN
MIN(list)

list = cells, ranges, or expressions 

MIN is the opposite of MAX, and returns the smallest value in its list. Positive numbers are always 
considered greater than negative numbers, even if the absolute value of the positive number is lower. 

Like MAX, MIN accepts several types of data in its parentheses, including a list of expressions, constants,
cell references, or range designations. Separate each cell reference or range designation by commas in 
the list. You can also use cell or range names in the list, or actual numbers. You can mix expressions 
combining cells, operators, and numbers.    MIN ignores empty cells and cells that contain labels.

Examples:

MIN(100,279,310,261,250-2) = 100.00



MINUTE
MINUTE(timestamp)

timestamp = a positive integer less than 86,400, representing the number of elapsed seconds 
from the beginning of the day. You can supply a timestamp as the result of the TIME or NOW 
functions, or enter it directly as a number.

MINUTE returns the minute number (0-59) for timestamp. MINUTE does not return the total minutes, only 
the number of minutes into the current hour. To enter the total minutes in a time value in cell A1, use the 
MINUTES function and enter 0 for the second timestamp.    See the MINUTES function for additional 
information.    

Examples:
MINUTE(10861) = 12:01pm
MINUTE(7200) = 0



MINUTES
MINUTES(timestamp,timestamp)

timestamp = a positive integer less than 86,400, representing the number of elapsed seconds 
from the beginning of the day. You can supply a timestamp as a result of the TIME or NOW 
functions or enter it directly as a number.

MINUTES returns the number of minutes difference (including the fractional component) between the first 
and second timestamps. MINUTES returns ERR if either of the timestamps contains a negative value, or 
a value of 86,400 or larger.

To return the number of minutes elapsed in the current hour, use the formula: MINUTES(NOW(),0)
Examples:

MINUTES(7201,3601) = 60.00
MINUTES(3601,7201) = -60.00
MINUTES(A2,A1)



MIRR
MIRR(range,riskrate,saferate)

range = a range of cash flow amounts comprising the investment

riskrate = the interest rate you expect to receive from an investment of a comparable risk 
(reinvestment rate)

saferate = a value that represents the interest rate on a safe investment, like a savings account, 
CD, savings bond, or treasury bill (liquid rate)

The MIRR function calculates the modified internal rate of return on an investment. Like IRR, MIRR 
analyzes cash flows. MIRR is considered a more reliable measurement of the actual return rate than IRR.
MIRR allows both negative and positive cash flows and removes the assumption that all cash flows are 
reinvested or discounted at the same interest rate. With MIRR, negative (liquid) cash flows are discounted
at the safe interest rate (such as a passbook account rate), while positive cash flows are reinvested at the
risk rate (or the return on an investment of comparable risk.)

MIRR obtains the future value of positive cash flows at the risk rate, the present value of the negative 
cash flows at the safe rate, and solves for an interest rate.

Values for IRR and MIRR are useful in comparing the attractiveness of two or more investments. 



MOD
MOD(X,Y)

X = a numeric value

Y = a numeric value other than zero

MOD stands for modulus, and returns the remainder of dividing X by Y. MOD always returns a result 
smaller than Y.

Entering zero for the Y value results in ERR because you cannot divide by zero.

Suppose 120 people were going to ride buses to a baseball game. Each bus holds 55 riders. Divide 120 
by 55 to determine the number of buses needed (2). Use the formula MOD(120,55) to determine how 
many people remain needing a ride. You could use that result (10) to determine if you need another bus. 
In this case, a few cars or a large van might be more appropriate than a third bus that would be almost 
empty.

 Examples:
MOD(120,55) = 10.00
MOD(A3,A4)
MOD(B5*3,C1/2)



MONTH
MONTH(datestamp)

datestamp = the integer date produced using the DATE, TODAY, or JULIAN functions, or any integer 
between 1 and 3,652,488. It represents the number of days since January 1, 0001.

MONTH returns the calendar month (1-12) of datestamp.

Examples:
MONTH(32584) = 3.00 (for March)
MONTH(A1)



MONTHS30
MONTHS30(datestamp,datestamp)

datestamp = the integer date produced using the DATE, TODAY, or JULIAN functions, or any integer 
between 1 and 3,652,488. It represents the number of days since January 1, 0001.

MONTHS30 returns the number of months between the first and second datestamps, based on a 360 day
year (30 day month). MONTHS30 returns ERR if either parameter is not a valid datestamp or if either 
datestamp represents    the 31st day of the month.

Examples:
MONTHS30(A1,A2)



MONTH$
MONTH$(datestamp )

datestamp = the integer date produced using the DATE, TODAY, or JULIAN functions, or any integer 
between 1 and 3,652,488. It represents the number of days since January 1, 0001.

MONTH$ returns the month in datestamp expressed as a string.    Datestamp must be the number of days
from the start of the Anno Domini calendar. It returns ERR if    datestamp is out of range.

Examples:
MONTH$(234987) = May
MONTH$(A2)



N
N(cell or range)
N returns the value of cell, or the value of the cell in the top-left corner in range. N returns a zero if the cell
contains a label or string.



NA
NA( )
Enter NA into a cell when the data it should contain is not available. NA has no number. Like ERR, when a
formula in the sheet refers to a cell with NA, the NA becomes the result of that formula.

Use NA as a place keeper when you are setting up formulas in    spreadsheets, but do not yet have all 
your information. It prevents formulas relying on unavailable data from displaying incorrect results.

NA does not require a parameter, but you must include the parentheses. 



NOT
NOT(X)

X = a comparison expression or numeric value

NOT reverses the true/false result of a comparison expression. For example, if you enter: 10>15 Lucid 3-
D returns a FALSE result (0.00). If you enter NOT(10>15), Lucid 3-D returns a TRUE result, (-1.00).    With
the NOT function, nonzero values return FALSE (0.00) and zero values return TRUE.

When you use NOT with the values 0 and -1, NOT(1) is 0 and NOT(0) is -1.00.    



NOW
NOW( )
NOW returns the number of elapsed seconds from the beginning of the day. It reflects the time currently 
set in Windows and produces a timestamp value you can use in other time functions.

NOW does not require a parameter, but you must include the parentheses. Lucid 3-D recalculates NOW 
each time you press F9 (Calc), so you can keep it current as time passes. 

Examples:
HOUR(NOW()) 
MINUTE(NOW())
SECOND(NOW())
NOW()



NPV
NPV(range,rate)

range = the range of cells containing the future cash flow amounts

rate = interest rate per period (entered as a decimal)

NPV calculates the net present value of a series of future cash flows. NPV is similar to PV (the present 
value function), but works with variable cash flows. Like PV, NPV assumes a constant interest rate and 
equally spaced payments.    

With NPV, cash can flow in two directions: enter outgoing cash flows as negative numbers, incoming cash
flows as positive numbers. NPV treats blank cells as zero.



NULL
NULL(list)

list = cells or ranges

NULL tests a cell, range of cells, or list of cells and ranges to see if they are empty. If any cell in its list 
contains a value, NULL returns FALSE (0.00). If all cells in the list are empty, NULL returns TRUE (-1.00).

You can include single cell references, range designations, cell or range names in the list.

 Examples:
NULL(A1:A5,A10:A11,A15)



NUMBER$
NUMBER$(X)

X  = a numeric value

NUMBER$ returns the string equivalent of X. Use NUMBER$ to convert a numeric value to a string for 
use by other string functions. If X contains all zeros to right of the decimal point, NUMBER$ removes the 
zeros and the decimal point. NUMBER$ returns ERR if X is not a constant value.

Examples:
NUMBER$(11.00) = 11
NUMBER$(C11)



OFFSET
OFFSET(cellref,layers,rows,cols,depth,height,width)

cellref = a valid cell reference

layers = a numeric value that identifies the number of layers from cellref to offset

rows = a numeric value that identifies the number of rows from cellref to offset

cols = a numeric value that identifies the number of columns from cellref to offset

depth = a numeric value that identifies the number of layers in the resulting range

height =a numeric value that identifies the number of rows in the resulting range

width =a numeric value that identifies the number of columns in the resulting range

OFFSET returns a range reference that is layers, rows, and columns distance from cellref.    Depth, 
height, and width specify the size of the range reference. 

OFFSET adds the value of layers to the layer value in cellref, adds row to the row value in cellref, adds 
column to the column value in cellref, and returns a range reference beginning at that cell.    The range 
reference consists of depth layers, height rows, and width columns.    

OFFSET returns ERR if depth, height, or width contain negative values, if the resulting offset is not within 
the bounds of the spreadsheet, if any arguments contain string or label values, or if cellref contains an 
invalid cell reference.

Example:
OFFSET(A::A2, 2,2,2,3,3,3) = C::E4..F::H7



OR
OR(comparison expressions)

comparison expressions = one or more comparison expressions, separated by commas, that 
evaluate to TRUE or FALSE

OR evaluates the expressions in comparison expressions, and returns TRUE if at least one of the 
expressions evaluate to TRUE. OR returns FALSE if none of the comparison expressions evaluate to 
TRUE.    

Although Lucid 3-D allows you to enter an OR function into a cell, it is most useful in an IF statement to 
determine if one of two or more conditions are true.    The following statement compares the contents of 
two cells and displays a message based on the result of the compare:

IF(OR(A::A1<B::A1,B::A1>C::A1),CONCAT$(" "Higher Sales!"),CONCAT$("High Sales!"))
if the contents of the cell B::A1 contains a larger value than the contents of cell A::A1 or B::A1 contains 
larger value than cell C::A1, this formula prints "Higher Sales".    If both cells C::A1 and cell A::A1 contain 
larger values than cell B::A1, this formula displays "High Sales".

Examples:
OR(FALSE(),TRUE()) = 0.00 (TRUE)
OR(A1,A2)



PI
PI( )
PI returns the constant, 3.1415926535898. PI represents the ratio of a circle's circumference to its 
diameter. You can type PI() when you need this value in calculations.

PI does not require a parameter, but you must include the parentheses that follow it.

Examples: 
PI( ) = 3.14
PI( )/3 = 1.05
PI( )*A4



PMT
PMT(principal,rate,term)

principal = a positive numeric value representing the amount of money to borrow

rate = interest rate per period expressed as a decimal

term = a positive integer representing the number of payment periods

PMT calculates the payment per period on a loan, assuming a constant annual interest rate and equally 
spaced periods for the term. PMT is based on the following formula:

PMT = principal*rate/(1 - (1 + rate)^-term)

Examples:
1. Payment on a loan of $15,000 borrowed at 8% APR for 5 years (with monthly payments):

PMT(15000,.08/12,60) = 304.15



POWER
POWER(X,Y)

X = a numeric value

Y = a numeric value

POWER returns the value of raising X to the power of Y.

Examples:
POWER(4,2) = 16.00
POWER(10,3) = 1000.00
POWER(A1,A2)



PPMT
PPMT(principle,rate,term,periodnumber)

principal = a positive numeric value representing the amount of the loan

rate = interest rate per period expressed as a decimal

term = a positive integer representing the number of payments 

periodnumber = a positve integer identifying the payment number of term

PPMT returns the principle portion of a loan payment for a certain payment number.    PPMT calculates 
the principle payment based on the principle borrowed for term amount of time, at an interest rate of rate.  
PPMT assumes that rate contains a constant annual interest rate and the number of payment periods in 
term are equally spaced throughout term.

PPMT calculates the amount of principle included in a loan payment for a certain payment number.    For 
example, to determine the amount of principle contained in payment number 3 of a $15,000 loan at 8% 
interest for 60 months, use the following formula:

PPMT(15000,.08/12, 60,3)
PPMT returns ERR if any of the parameters contain non-numeric values. See the PPMT function to 
calculate the amount of principle payment contained in a loan payment, and the PMT function to calculate
the total amount of a payment.    PMT calculates the amount of payment on a loan at an interest rate, 
IPMT calulates the amount of interest contained in the payment, and PPMT calculates the amount of 
principle.    

Note: Due to rounding, the amount that PPMT and IPMT return may not total exactly to the amount PMT 
returns. PPMT and IPMT are accurate to plus or minus one cent.

Examples:
1.    What monthly payment is required to repay $10,000 at 7.5% interest for 36 months? How much 
interest does the 12th payment include and how much principle does it include?

PMT(10000,.075/12,36) = 311.06 (the amount of payment)

PPMT(10000,.075/12,36,12) = 3.45 (the amount of principle in the 13th payment)

IPMT(10000,.075/12,36,12) = 307.61 (the amount of    interest in the 13th payment)

2.    PPMT(A1,B1/12,C1,D1) computes the amount of principle payment on the principle in cell A1 at the 
interest rate in B1, for the term in C1, for the period number in D1.



PRODUCT
PRODUCT(cells or ranges)
PRODUCT returns the product of all numeric values in the list of cells. PRODUCT ignores strings, labels, 
and NA references. If PRODUCT encounters a cell containing ERR or non-numeric values, it returns 
ERR.

Examples:
PRODUCT(3,5,7) = 105
PRODUCT(A1:A5)
PRODUCT(A1:A5,7,3,5,6+A4)



PROPER$
PROPER$(string)

string = a valid string value

PROPER$ converts all letters in string to proper case. Proper case is defined as capitalizing the first letter
in the string, and any other letters in the string that follow any character other than a letter. PROPER$ 
converts all remaining letters to lowercase.    PROPER$ returns ERR if you specify a nonstring value.

Examples:
PROPER$("LUCID 3-D") = Lucid 3-D
PROPER$(A5)



PV
PV(payment,rate,term)

payment =    the amount to pay each period

rate = the interest rate per period expressed as a decimal

term = the number of payments to make

PV returns the present value of a set of cash flows, assuming a constant interest rate and equally spaced 
payments. PV is based on the following formula:

PV = payment*(1 - (1 + rate)^-term)/rate

Examples:
PV(250,.10/12,60) = $11,766.34
PV(560,.135/12,360) = $48,890.70



RADIANS
RADIANS(degrees)

degrees = an angle representation

RADIANS converts an angle representation in degrees to radians.    A circle consists of 360 degrees or 
2*PI radians.

Examples:
RADIANS(30) = .52
RADIANS(90) = 1.15
RADIANS(A1)



RAND
RAND( )
RAND generates a random number between zero and one. RAND requires no argument, but you must 
include parenthesis.

RAND returns a different non-inclusive value each time you recalculate the spreadsheet with F9(Calc). To
generate a random number larger than one, multiply the RAND result by a larger number.

 Examples: 
RAND( )
RAND( )*100

generates a random value between 0 and 100



RANDOM
RANDOM(X)

X = a numeric value between 0 and 32,767

RANDOM returns a random integer between 0 and X-1. You can optionally seed the random number 
generator by executing a RANDOMIZE function.

Examples:
RANDOM(1001) = an integer between 0 and 1000
RANDOM(A5)



RANDOMIZE
RANDOMIZE(X)

X =a positive integer that acts as the random number seed

RANDOMIZE initializes the random number generator, based on the random number seed X. If X 
contains 0, RANDOMIZE initializes the random number generator with a random value. If X is in the 
range 1-65535, RANDOMIZE uses X to set the random number generator to a new starting point. 

RANDOMIZE returns a predetermined sequence of numbers if X contains the same value on subsequent 
executions. This is useful during testing procedures to test with the same set of numbers on multiple 
iterations.

Examples:
RANDOMIZE(0)
RANDOMIZE(10000)
RANDOMIZE(D2) 



RANGE
RANGE(cellref,cellref)

cellref  = a valid cell reference

RANGE returns a range reference that includes the cell references in both parameters.    The first cell 
reference represents the cell in the upper left corner of the top layer in the range.    The second cell 
reference represents the cell in the lower right corner of the bottom layer in the range.    

RANGE returns an error if cellref in invalid, if the layer value in the second cellref is smaller than the layer 
value in the first cellref, if the row value in the second cellref is smaller than the row value in the first 
cellref, or if the column value in the second cellref is smaller than the column value in the first cellref.



RANGEOF
RANGEOF(cellref)

cellref  = a valid cell reference

RANGEOF converts a cell reference to a range reference that consists of a layer, row, and column value.  
RANGEOF returns ERR, if cellref is not a valid cell reference.



RATE
RATE(future value,present value,term)

future value = the value of the investment at the end of term

present value = the current value of the investment

term = the number of compounding periods 

RATE calculates the interest rate that yields a future value, given the present value and the term (number 
of periods). RATE assumes a fixed interest rate and regular intervals.

Examples:
1. What monthly interest rate would be used if $5,000 became $10,000 in 5 years?

RATE(10000,5000,5*12) = .0116 (1.16%)
The monthly rate (1.16)    multiplied by 12 yields the A.P.R. (13.94).

2. What would be the rate that $100,000 increased in value to $500,000 in 10 years with annual 
compounding?
RATE(500000,100000,10) = .174 (17.4%)



REF
REF("filename", cellref)

filename = the name of the file that contains the cell to reference

cellref = identifies the cell to reference in filename

REF establishes a link between two spreadsheets. It allows you to include the contents of a cell from a 
different spreadsheet in the cell that contains the REF function. 

Include the layer value in cellref. If you omit the layer in cellref, Lucid 3-D assumes the top layer of the 
spreadsheet named in filename.

Lucid 3-D searches its home directory, LUCID3DW, for filename. If the spreadsheet you want to refer to is
in a different directory, include the complete pathname in filename.

Examples:
REF("SALES.LCW",A12) inserts the contents of cell A12 of the top layer of the spreadsheet 

SALES.LCW, in the current cell. 
REF("C:\WESTERN\SALES.LCW",IDAHO::B22) inserts the contents of cell B22 in the layer 

named IDAHO of the spreadsheet SALES.LCW in the WESTERN directory, in the current 
cell.



REPEAT$
REPEAT$(string,count)

string = a valid string

count = a positive integer

REPEAT$ returns a text string made up of string repeated count times. REPEAT$ returns ERR if count 
contains a negative value.

Examples:
REPEAT$("LUCID",3) = LUCIDLUCIDLUCID
REPEAT$(N12,10)



REPLACE$
REPLACE$(string,column,count,newstring)

string = a valid string

column = an integer between 1 and the length of    string

count = a positive integer    

newstring = a valid string

REPLACE$ returns a string with newstring replacing characters in string beginning at column.    Count 
specifies the number of characters to replace. REPLACE$ returns ERR if column is less than 1 or greater 
than the length of the original string, or if count is less than zero or greater than the number of characters 
remaining in the string.

Examples:

REPLACE$("Dear Mr. Brown:",6,2,"Mrs") = "Dear Mrs. Brown:"
REPLACE$(A5,7,10,A6)



RIGHT$
RIGHT$(string,count)

string = a valid string

count =    a positive integer

RIGHT$ returns a substring of string. Count specifies the number of characters to return.    If count 
exceeds the length of string, RIGHT$ returns the entire string.    RIGHT$ returns an error if count is 
negative or not an integer.

Examples:
RIGHT$("Lucid 3-D for Windows",7) = "Windows"
RIGHT$(A7,10)



ROUND
ROUND(X,Y)

X = a numeric value

Y = an integer 

ROUND returns X rounded to Y decimal places.    If decimals contains a negative integer, ROUND returns
a value that contains no digits to the right of the decimal point, and changes decimal digits to the left of 
decimal point to 0. 

Examples:
ROUND(1.5,0) = 2.00
ROUND(4567.89,-2) = (45.00)
ROUND(1.5555,2) = 1.56
ROUND(A2,B7)



ROW
ROW(cell or range)
ROW returns the row number of a cell reference. If you include a range reference, ROW returns the top 
left corner of range.    ROW returns ERR if you specify an invalid cell or range reference.

Examples:
ROW(B7) = 7



ROWS
ROWS(cell or range)
ROWS returns the number of rows in range.    ROWS returns 1 for cell references.

Examples: 
ROWS(A1:Z45) = 45.00
ROWS(All) = 9999



S
S(range)

range  = a valid range reference

S returns the string value in the cell in the upper left corner of range.    S returns ERR if you specify an 
invalid range.    S returns an empty string, if the cell does not contain a string value.

Examples:
S(A1..B2)



SEARCH
SEARCH(substring,searchstring,column)

substring = a valid string

searchstring = a valid string

column = a positive integer

SEARCH returns the position of substring in searchstring. Search begins at column and continues to the 
end of the string.    Specify control characters in the substring by prefixing them with the tilde character 
(~). SEARCH interprets, "~J" as Control-J.    To find an actual tilde character, use "~~". 

SEARCH returns ERR if no match is found, if the substring is a null string (""), or if the starting column is 
less than 1. 

Note: SEARCH performs a case-insensitive search.

Examples:
SEARCH("Lucid 3-D for Windows","Windows",6) = 15.00
SEARCH(A1,A2,10)



SECOND
SECOND(timestamp)

timestamp = a positive integer less than 86,400 representing the number of elapsed seconds from the
beginning of the day. You can use the TIME or NOW functions to produce timestamp or enter it as
a number.

SECOND gives the second number (0-59) of timestamp. 

Examples:
SECOND(34567) = 7.00
SECOND(F4)



SECONDS
SECONDS(timestamp,timestamp)

timestamp = a positive integer less than 86,400 representing the number of elapsed seconds from the
beginning of the day. You can use the TIME or NOW functions to produce timestamp or enter it as
a number.

SECONDS returns the number of seconds difference (including the fractional component) between the 
first and second timestamps. SECONDS returns ERR if either of the timestamps is out of range.

Examples:
SECONDS(6534,4323) = 2211.00
SECONDS(B3,D4)



SIGN
SIGN(X)

X = a numeric value

SIGN returns one (1.00) if the sign of X is positive, zero (0) if X is equal to zero (0), and 1.00 if X is 
negative. SIGN returns ERR if X is not numeric.

Examples:
SIGN(-50) = -1
SIGN(455) = 1
SIGN(A8)



SIN
SIN(X)

X = a numeric value

SIN returns the sine of the angle X (in radians). Lucid 3-D includes the radians() and degrees() functions 
to convert between the two angle measurements. 

Examples:
SIN(PI()/4) = 0.71
SIN(B2)
SIN(C1/C2)



SINH
SINH(X)

X = a numeric value

SINH returns the hyperbolic sine, the inverse sine of the angle X (in radians). Lucid 3-D includes the 
radians() and degrees() functions to convert between the two angle measurements. 

Examples:
SINH(PI()) = 11.55
SINH(C22)



SLN
SLN(Cost,Salvage,Life)

cost = purchase price of the asset

salvage = expected value of the asset at the end of its useful life

life = number of periods for that the asset is useful

SLN is the straight-line method of depreciation of a capital asset. SLN returns the loss for any one period 
during the life of an asset. With SLN, each year or period's depreciation is the same throughout its life. 

Examples:
1. Equipment purchased for $500,000, lasting 10 years and worth $50,000 when sold:

SLN(500000,50000,10) = 45000.00

2. Equipment purchased for $100,000, worth $30,000 at the end of 5 years:
SLN(100000,30000,5) = 14000.00



SQRT
SQRT(X)

X = a numeric value greater or equal to zero.

SQRT returns the square root of X. The square root is the number that, when multiplied by itself, equals 
X. SQRT(9) is 3 because 3*3=9.

SQRT returns ERR, if X is negative.

Examples:
SQRT(16) = 4
SQRT(B5)



STD
STD(list)

list = cells, ranges, or expressions

STD returns the standard deviation of its list of values, cell references, ranges, and expressions. The 
standard deviation measures the disbursement of the numbers in the list around the average of those 
numbers. If you take the list as a distribution, the average describes the central value. The standard 
deviation represents the width of the distribution. 

The smaller the standard deviation, the closer the numbers in the list are to each other. If all the numbers 
in the list are identical, the standard deviation is zero. 

STD represents the population standard deviation as opposed to the sample standard deviation. See the 
STDS function for sample standard deviation. The list can consist of ranges, values, and formulas. STD is
actually the square root of the VAR function.

Examples:
STD(1,2,3,4,5) = 1.41
STD(C1,D1,Totals)



STDS
STDS(list)

list = cells, ranges, or expressions

STDS returns the standard deviation of sample data in a list of values. The list can contain cell 
references, ranges, and expressions. The standard deviation measures the disbursement of the numbers 
in the list around the average of those numbers. If you take the list as a distribution, the average 
describes the central value. The standard deviation represents the width of the distribution. The smaller 
the standard deviation is, the closer the numbers in the list are to each other. If all the numbers in the list 
are identical, the standard deviation is zero.    See the STD function to find standard deviation for the 
population. STDS is considered more accurate when only a portion of the population is available for 
calculations.

STDS returns the square root of the VARS function.

Examples:
STDS(1,2,3,4,5) = 1.58
STD(A1:A5)



SUBST$
SUBST$(string, oldsubstring, newsubstring {,instance})

string = a valid string 

oldsubstring = a valid string 

newsubstring = a valid string 

instance = a positive integer 

SUBST$ returns a string consisting of string with one or more occurrences of oldsubstring replaced by 
newsubstring.

If    you include instance, SUBST$ replaces the instance occurrence of oldsubstring. If you omit instance 
SUBST$ replaces all occurrences of oldsubstring. SUBST$ returns string if instance exceeds the number 
of occurrences of oldsubstring.    

SUBST$ returns ERR if you include empty strings for string or oldsubstring; or if instance is negative. 

Note:    SUBST$ performs a case-sensitive search.

Examples: 
SUBST$("Lucid 3-D for DOS","DOS","Windows") = "Lucid 3-D for Windows"
SUBST$(A1,A2,A3,4) locates the fourth instance of A2 in A1 and replaces it with A3.



SUM
SUM(list)

list = cells or ranges containing numbers to be totaled 

SUM calculates the sum of a list of values and displays the total.

The SUM function accepts a list of expressions, constants, cell references, or range designations. 
Separate each cell reference or range designation by commas. You can mix expressions, combine cells, 
operators, and numbers.

SUM ignores cells containing labels.

Examples:
SUM(A5:C7)
SUM(A5:C7,D4,TOTAL)
SUM(A2,A3,A4,A5,A6)
SUM(A5:C7,D8:F11,8)
SUM(B4-1,B3+B2)
SUM(5-4,3*3)



SUMPRODUCT
SUMPRODUCT(range1,range2)

range = valid range references of the same dimensions

SUMPRODUCT returns the dot product of two arrays in range1 and range2. The arrays must contain the 
same number of rows and columns.

SUMPRODUCT multiplies the values of the cell in the upper left corner of range1 by the value of the cell 
in the upper left corner of range2.    It adds that product to the product of the cell in the next row or column
of the ranges.    SUMPRODUCT repeats this multiplication and addition until it multiplies the values of the 
cells in the lower right corners of the ranges.

SUMPRODUCT skips cells that contain nonumeric values. SUMPRODUCT returns an error if the ranges 
contain a different number of rows or columns.



SYD
SYD(Cost,Salvage,Life,Period)

cost = the asset's purchase price

salvage = the expected value of the asset at the end of its useful life

life = the number of periods that the asset remains useful

period = the depreciation period 

SYD returns sum of years digits depreciation. SYD, like the function DDB, calculates a larger depreciation
in the early years of an asset's life and smaller amounts near the end. 

With SYD, the fractional depreciation in any year equals the number of years remaining divided by the 
sum of the years. A five-year life means remaining years divided by 1+2+3+4+5, or remaining years/15. 
The first year has a depreciation fraction of 5/15th, meaning 1/3rd of the depreciation occurs in that year. 
The fifth year would be 1/15th of the depreciation.

Examples:
1. Depreciation for first year, $500,000 purchase price, $50,000 salvage value after 5 years:

SYD(500000,50000,5,1) = $150,000

2. Same example in the third year:
SYD(500000,50000,5,3) = $90,000



TAN
TAN(X)

X = a numeric value

TAN returns the tangent of the angle X (in radians).    

Lucid 3-D includes the radians() and degrees() functions to convert between the two angle 
measurements. 

Examples:
TAN(PI()/4) = 1.73
TAN(C2)



TANH
TANH(X)

X = a numeric value

TANH returns the inverse tangent of the angle X (in radians). Lucid 3-D includes the radians() and 
degrees() functions to convert between the two angle measurements.    

Examples:
TANH(PI()/3) = .78
TANH(C5)



3DLOOKUP
3DLOOKUP(range, layercondition, layerkey, rowcondition, rowkey, columncondition, columnkey)

range = the range 

layercondition = a comparison operator

layerkey = a numeric value or string

rowcondition = a comparison operator

rowkey = a numeric value or string

columncondition = a comparison operator

columnkey = a numeric value or string

3DLOOKUP is a three dimensional table lookup function. It returns a cell reference at the intersection of 
three separate searches and each of the searches contributes a spreadsheet attribute to the resulting cell
reference.    The searches that 3LOOKUP performs are:

· It searches for layerkey based on layercondition, in all cells in the upper left corner of all layers in 
the range.    This is the first search and the cell that satisfies the condition contributes the layer 
component of the resulting cell reference.

· It searches for rowkey based on rowcondition, along the leftmost column in the top layer of the of 
range.    This is the second search and the cell that satisfies the condition contributes the row 
component of the resulting cell reference.

· It searches for columnkey based on columncondition, in the top row of the top layer in range.    
This is the third search and the cell that satisfies the condition contributes the column component 
of the resulting cell reference.

You can specify a string or numeric value or a cell reference containing a string or numeric value, for 
layerkey, rowkey, or columnkey.    You may include any of the following comparison operators for 
condition: "<", "<=", "=", ">=", or ">".

If 3DLOOKUP locates a match for all three conditions it returns the cell at the intersection of the three 
cells that satisfy the three conditions.    3DLOOKUP skips empty cells and cells that contain a different 
data type than key.    3DLOOKUP returns ERR if it fails to locate a cell that satisfies any of the conditions 
and keys.

Examples:
3DLOOKUP(A::A3:N::E10, "<", 0, ">", 0, "=", 0)

Searches the cells in B::A1 through N::A1 for a negative value, the cells in A::A3 through A::A10 
for a positive value, and the cells in A::A3 through A::E3 for a value of 0.    If 3DLOOKUP locates a
negative value in cell C::A3 during the first search, and a positive value in cell A::A5 during the 
second stage of the search, and a value of 0 in the cell A::E3 during the third stage of the search, 
it returns the cell at the intersection of those three cells.    That cell is C::E5 because it found the 
match for the layer condition in layer C, the match for the row condition in row 5 and the match for
the column condition in column E.



TERM
TERM(payment,rate,future value)

payment = the amount to pay per period

rate =    the fixed interest rate per period, expressed as a decimal

future value = the value the investment will reach

TERM calculates the number of periods to accumulate future value, with payment amount and interest 
rate.

Examples:
1. How long will it take to accumulate $50,000, at 8.25% interest, adding $2,000 per year?

TERM(2000,.0825,50000) = 14 years

2. Number of $500 payments needed to reach $10,000 at 9.5% interest:
TERM(500,.095,10000) = 12 payments



TIME
TIME(hour,minute,second)

hour = an integer between 0 and 23

minute = an integer between 0 and 59

second = a numeric value between 0 and 59

TIME returns the number of elapsed seconds from the beginning of the day, based on hour, minute, and 
second. Second may contain a fractional value. TIME produces a timestamp to use in other time 
functions.

Examples:
TIME(11,30,15) = 41415.00
TIME(18,0,0) = 64800.00



TIME$
TIME$(timestamp,rollover{,decimals})

timestamp = a positive integer less than 86,400 representing the number of elapsed seconds from the
beginning of the day. Use the TIME or NOW functions to produce timestamp or enter it directly as 
a number.

rollover = the numbers 12 or 24

decimals = a positive integer between 0 and 10

TIME$ returns the value of timestamp expressed as a string value representing the time of day based on 
a 12 or 24 hour clock. If rollover contains 12, TIME$ appends the "am" or "pm" designator to the 
timestring.    

Examples:
TIME$(49879,12) = 01:51:19 pm
TIME(C3)



TIMEVALUE
TIMEVALUE(timestring)

timestring = a string value containing a time, or a timestamp converted to a timestring with the TIME$ 
function

TIMEVALUE converts timestring to a timestamp for use by other Lucid 3-D time functions. timestring can 
include an am or pm designator, and fractions of a second.

Examples:
TIMEVALUE("01:51:19 pm") = 49879.00
TIMEVALUE(A2)



TODAY
TODAY( )
TODAY returns the number of days (a dataestamp) from the beginning of the Anno Domini calendar ( i.e. 
January 3, 0001 A.D. = 2 days) to the current date.    

TODAY does not require a parameter, but you must include parentheses.



TRIM$
TRIM$(string)

string  = a valid string

TRIM$ removes all extraneous spaces from string, except for single spaces between words. TRIM$ 
returns ERR if you enter an invalid string.

Examples:
TRIM$(" Lucid 3-D    For      Windows    ") = "Lucid 3-D for Windows"
TRIM$(A21)



TRUE
TRUE( )
TRUE is logical value -1.00. The only one other logical state is FALSE, whose logical value is (0.00). 
When used with the NOT function, NOT(TRUE) is FALSE and equals 0.00. NOT(FALSE) is TRUE and 
equals -1.00.

Using TRUE and FALSE improves readability of formulas. It is easier to understand a formula like 
IF(A1=TRUE(),B1,C1) than the formula IF(A1=-1,B1,C1).

TRUE does not require a parameter, but you must include the parentheses.



TRUNC
TRUNC(X{,decimals})

X = a numeric value

decimals = an integer value in the range -20 to 20

TRUNC returns the value of X, after changing digits to the right or left of the decimal point to 0. If decimals
contains a positive integer, TRUNC returns a value that contains decimals digits to the right of the decimal
point. 

TRUNC returns ERR if decimals is not an integer value or if it is greater than 20 or smaller than -20.

Examples:
TRUNC(1234.5678,1) = 1234.50
TRUNC(1234.5678,-1) = 1230.00
TRUNC(B3)



TYPE
TYPE(expression)

expression = a numeric or string value, a range or cell reference

TYPE returns an integer indicating the data type of expression.    Possible return values and their meaning
are:

1 an empty cell

2 a numeric value

3 a string value

4 a label

5 an NA value

6 an ERR value

7 a range reference



UPPER$
UPPER$(string)

string = a valid string

UPPER$ converts all lowercase letters in string to uppercase, and ignores numbers.    UPPER$ returns 
ERR if you enter an invalid string.

Examples:
UPPER$("Lucid 3-D") = "LUCID 3-D"
UPPER$(D4)



VALUE
VALUE(string)

string = a valid string

VALUE returns string as a numeric value.    Value ignores leading spaces and tabs in string.    Value 
recognizes numeric digits, decimal points, + and - signs, commas, dollar signs, and e or E in the string 
value.    

Value terminates when it encounters the first invalid character in string, and returns the result of the 
conversion before encountering the invalid characters. VALUE returns ERR if you specify an invalid 
string.

Examples:
VALUE("132AB") = 132
VALUE("    1B") = 1
VALUE(C3)



VAR
VAR(list)

list = cells, ranges, or expressions

VAR returns statistical population variance of its list of values, references, ranges, and expressions.    The 
variance represents the length of the distribution of values in list.    A small variance represents numbers 
that are close together.

Examples:
VAR(2,2,2,2,3,4) = .58
VAR(1,5,6,7,8,20) = 34.47



VARS
VARS(list)

list = cells, ranges or expressions

VAR calculates the sample variance of its list of values, cell references, ranges, and expressions.

Like VAR, VARS measures the disperment of the numbers in the list around the average of those 
numbers. VARS represents the "sample" variance, as opposed to the "population" variance that VAR 
provides. The list can consist of ranges, values, and formulas. 

Examples:
VARS(2,2,2,2,3,4) = .7
VAR(1,5,6,7,8,20) = 41.37



VERSION
VERSION()
VERSION returns the current version number of Lucid 3-D for Windows as a number. As improvements 
are made the Version number increases, as in 2.00, 2.20, 2.55. Your Support Advisor may ask you for this
number if you call for technical assistance.

VERSION requires parenthesis.



VERSION$
VERSION$
VERSION$ returns the current version number of Lucid 3-D for Windows as a string value.



VLOOKUP
VLOOKUP(range,condition,key,layeroffset,rowoffset)

range = a valid range reference

condition = a comparison operator enclosed in quotes

key = a numeric value or string

layeroffset = a positive integer

columnoffset = a positive integer

VLOOKUP is a one dimensional, vertical table lookup function.    It searches for key in the leftmost column
in range, based on condition.    

You can specify a string or numeric value for key, or a cell reference containing a string or numeric value. 
You may include any of the following comparison operators for condition: "<", "<=", "=", ">=", or ">".

Layeroffset and columnoffset define the layer and column of the cell VLOOKUP returns.    When 
VLOOKUP locates a cell containing key that satisfies condition, VLOOKUP returns the contents of the cell
that is layeroffset layers deeper and columnoffset columns to the right of the cell that satisfies the 
condition.    You may include a string or numeric value for key.

VLOOKUP skips empty cells and cells that contain a different data type than key.    VLOOKUP returns 
ERR if it fails to locate a cell that satisfies key and condition, if layeroffset or columnoffset contain 
negative or non-numeric values, or if layeroffset or columnoffset generate a cell reference outside of 
range.

Examples:
VLOOKUP(A::A1:D::E10, "<", 100, 1, 2 )

Searches the cells in column A of layer A in rows 1 through 10 for a value less than 100.    When it
locates a value less than 100, it returns the contents of the cell one layer deeper and two columns
to the right of the cell that contains the value.    For example, if VLOOKUP locates the value 98 in 
the cell in layer A, row 1, column A, it returns the value in the cell at layer B, row 2, column A.    

VLOOKUP(B::B2:E::L10, "<", 0, 0,1)
Searches row 2 of layer B in columns B through L for negative values and returns the contents of 
the cell immediately to the right of it. 



XOR
XOR(comparison expressions)

comparison expressions = one or more comparison expressions, separated by commas, that 
evaluate to TRUE or FALSE

XOR evaluates the expressions you include in comparison expressions, and returns TRUE if only one of 
the expressions evaluate to TRUE. XOR returns FALSE if more than one of the comparison expressions 
evaluate to TRUE.    

Although Lucid 3-D allows you to enter an XOR function into a cell, it is most useful in an IF statement to 
determine if only one condition is true. 

Examples:
XOR(FALSE(),TRUE()) = -1.00 (TRUE)
IF(XOR(FALSE(),FALSE(),TRUE())) = -1.00 (TRUE)
AND(A1,A2)



YEAR
YEAR(datestamp)

datestamp = the integer date produced using the DATE, TODAY, or JULIAN functions, or any integer 
between 1 and 3,652,488. It represents the number of days since January 1, 0001.

YEAR returns the year number from datestamp.

Examples:
YEAR(32867) = 90, the year 0090
YEAR(K4)
YEAR(TODAY()) = the current year



YEAR$
YEAR$(datestamp )

datestamp = the integer date produced using the DATE, TODAY, or JULIAN functions, or any integer 
between 1 and 3,652,488 It represents the number of days since January 1, 0001.

YEAR calculates the calendar year that an integer date falls in and returns it as a text string.

Examples:
YEAR$(134987) = 370
YEAR$(D7)



Keyboard
Function Keys
F1 Help
SHIFT+F1 Case-Sensitive Help
F2 Edit the current cell entry
F3 Edit the current cell's note
F4 Find data in the current spreadsheet
SHIFT+F4 Replace data in the current 

spreadsheet
CTRL+F4 Close the active spreadsheet/graph 

window
ALT+F4 Exit Lucid 3-D for Windows
F5 Goto a specific cell address
F7 Find Next
F8 Start range mode, end range mode
F9 Recalculate the current spreadsheet
F10 Enter the menu bar
F12 Save the active spreadsheet to a 

different location
SHIFT+F12 Save the active spreadsheet 
CTRL+F12 Open a spreadsheet in a new 

window

Keyboard Shortcuts
CTRL+A Change the alignment of cell 

contents
CTRL+B Add borders to cells
CTRL+C Copy the current selection to the 

clipboard
CTRL+F Change font of the current selection
CTRL+N Change cell numeric formatting
CTRL+P Change cell colors and background 

patterns
CTRL+S Insert specific properties at the 

current location
CTRL+V Insert the clipboard at the current 

location
CTRL+X Cut the selection and place in 

clipboard
CTRL+Z Undo most operations
DEL Erase the current selection
GREY+ Go down one spreadsheet layer
GREY- Go up one spreadsheet layer
CTRL+GREY+ Go down one linked file



CTRL+GREY- Go up one linked file
CTRL+HOME Go to the top left cell of the current 

spreadsheet
CTRL+END Go to the last occupied cell in the 

current layer
CTRL+RT ARRW Scroll one screen right
CTRL+LT ARRW Scroll one screen left
ALT+BKSPC Undo most operations



Cells
Cells are the main part of a Lucid 3-D spreadsheet for storing and manipulating data.



Active Range
The Active Range is a group of cells in the spreadsheet on which you can perform operations such as 
formatting, copying and pasting.



Floating Object
A floating object is an embedded drawing, graph or control    that can be added to highlight or identify 
different parts of the spreadsheet.



Title Area
The title area identifies the current spreadsheet file by its file name.



Row Labels
Row labels identify the rows of the spreadsheet. Click on the row label to select all cells in the row. Drag 
the line between the row labels to increase or decrease the height of the cell. You can select multiple rows
by dragging the mouse cursor across multiple row labels.



Column Labels
Column labels identify the columns of the spreadsheet. Click on the column label to select all cells in the 
column. Drag the lines between the column labels to increase or decrease the width of the cell. You can 
select multiple columns by dragging the mouse cursor across multiple column labels.



Select All Box
Click on the Select All box to select all cells of the current spreadsheet. All cells, including those on other 
layers, will be selected.



Tabs
Tabs identify the different layers in the spreadsheet. Use the Name Layers command (Tools menu) or 
click the right mouse button on a tab to change the name and colors of tabs.



Send File
Use this dialog to select the file you wish to send to the remote computer.



Receive File
Use this dialog to enter or select the file name you wish to save the received file with.



Save spreadsheet message
You have attempted to close a spreadsheet or exit Windows without saving changes made to it.

To close the spreadsheet without saving changes
· Choose the No button.

To close the spreadsheet and save the changes
1. Choose the Yes button.

2. If this is the first time to save the spreadsheet, supply a file name in the Save As dialog box.

3. Choose OK.

To cancel the close command
· Choose the Cancel button.



Invalid function format



Can't save spreadsheet
An attempt to save the spreadsheet has failed. Check the free space on the requested drive, deleting any 
unnecessary files.



Can't paint borders



Error in formula
You have made an error in typing in the formula. You can either edit your formula entry, or enter the 
function as a label. If you enter the function as a label, no calculations will be performed by this formula.

To enter the formula as a label
· Choose the Yes button.

To edit the formula
· Choose the No button.



Copy and paste region different shapes
You have tried to paste the clipboard to a range that is either too small, too large, or the wrong shape. 
Check the paste area and try again.



Can't find file
Lucid 3-D for Windows can not find the file that has been requested to be open. The file may be contained
on another drive or directory. Ensure the path is correct and try the command again.



Revert to a different version
You have made changes to a spreadsheet and tried to open it again, losing any unsaved changes.

To load the file version on disk
· Choose the OK button.

To cancel the open command
· Choose the Cancel button.



File load error
An error has occurred loading the requested file. Make sure that the file type is correct and that the file is 
a file that Lucid 3-D for Windows can open.



Save changes in [spreadsheet]?
You have made changes to a spreadsheet since the last time you saved the spreadsheet. By choosing 
the Close or Exit from the File menu,    Close All from the Window menu or exiting Windows you are 
closing the spreadsheet without saving the changes.

To save the changes to before closing or quitting
· Choose the Yes button.

To save changes to all spreadsheets
If you chose the Exit command from the File menu or the Close All command from the Window menu, you
are closing all spreadsheets that are currently open. 

· Choose the Yes to All button.

To discard changes and continue closing or quitting
· Choose the No button.

To cancel the close or quit operation and return to the active spreadsheet
· Choose the Cancel button.



Save Macros
You have added or changed a macro in the hidden macro sheet (MACROS.LCM). Exiting Lucid 3-D after 
adding or editing a macro will cause this message to appear.

To save changes to the macro sheet
· Choose the Yes button.

To discard changes made to the macro sheet.
· Choose the No button.

To cancel the exiting of Lucid 3-D
· Choose the Cancel button.



Paste same dimension
The area you are trying to paste has the same location as

 



Not version 1
The file you have selected is a connectivity pack that is too new to be supported by this version of Lucid 
3-D. Upgrade your version of Lucid 3-D before installing it.



Corrupt pack
The file you have selected is not a valid connectivity pack or has become corrupted. Try re-installing the 
pack from diskette and retry the operation.



Connectivity pack not found
The connectivity pack you have selected is no longer installed or is missing. Be sure the file is still 
accessible on the same path it was installed from or try re-installing it.



Connectivity pack not valid
The file you have selected is not a valid connectivity pack. Try re-installing the pack from diskette and 
retry the operation.



Already installed
The connectivity pack you are installing is already installed. You can install the same pack more than 
once if you wish to use more than one set of parameters in the setup of the pack. It will be named a 
different name that the pack already installed. 

To install the pack using a different setup
· Choose the Yes button.

To cancel installation of the pack
· Choose the No button.

To cancel installation of the pack and return to Lucid 3-D
· Choose the Cancel button.



Install pack
Requesting confirmation to install the requested connectivity pack

To install the pack
· Choose the Yes button.

To cancel installation of the pack
· Choose the No button.



Can't open file
The file requested cannot be read and/or translated properly. Be sure the file is of the correct type for the 
file extension supplied and retry the operation.



Unexpected end of line
The file contained a line that was too short to be understood.



Test true on playback?
You have selected to insert an IF statement in a recording macro. 

To insert the IF statement in the macro
· Choose the Yes button.

To cancel inserting the IF statement in the macro
· Choose the No button.



Replace existing file?
You are attempting to save a file to the same name and location of an existing file. 

To overwrite the file on disk
· Choose the Yes button.

To cancel the save
· Choose the No button.



Nothing to add
You have selected the Add button with nothing to add. Add your item before pressing the Add button.



Nothing selected
You have selected OK with nothing selected. try selecting an item first.



Choose a file
Use this dialog to choose the file you with to send or receive.



Unable to open communications port
Windows has reported to Lucid 3-D that it is unable to open the requested communications port. This is 
usually because that port doesn't exist on your hardware or is not operating correctly. Be sure that the 
port you have specified the correct port, the port settings are correct or try another port.



Insufficient memory
You have attempted to perform an operation that requires more memory than is currently available. Close 
any applications that you are currently not using and retry the operation.



Unable to initialize
Windows has reported to Lucid 3-D that it is unable to initialize the requested communications port. This 
can be caused by another program or process using the port at this time. Close all other tasks that might 
be using the port and try again.



Communications driver error
Windows has reported to Lucid 3-D that it is unable to open the requested communications port. This is 
likely due to an error in the driver. This occurs with add-on drivers or may be caused by your driver being 
corrupt. Try re-installing your driver or Windows and retry the operation.



Transfer complete
The file transfer you have requested is complete.



Transfer canceled
The file transfer has been canceled by either you or the remote unit.



Error opening file
An error has occurred while attempting to open the requested file. Make sure the file location and the file 
type are correct.



Windows timer request failed
This operation requires a timer to complete the operation. Windows reports that it cannot supply a timer at
this time. Try closing all other applications or restart Windows and retry the operation.



Edit Series Color
Use the Edit Series Color dialog to change the color and pattern of an individual graph series.

Dialog Box Options
Series Color Select the color for the graph series.

Series Style Select the series for the pattern style series.



Spreadsheet too big
The spreadsheet you have attempted to load is too large for Lucid 3-D. Try closing any open applications 
that are not necessary and try again.



Unable to 3-D link
Lucid 3-D can't establish a link the requested file. Make sure the file name in the REF function is a valid 
file name.



Invalid cell for 3-D link
The cell reference for the requested 3-D link is not valid for a 3-D linked cell. Make sure the cell reference 
exists in the attempted 3-D link spreadsheet.



Unable to return to parent spreadsheet
The parent spreadsheet for this 3-D linked spreadsheet is no longer a valid file. Make sure the file name 
and location are correct.



Add Lucid Function Pack
You have requested that a Function Pack be added to Lucid 3-D.

To install the Function Pack
· Choose the Yes button.

To cancel the installation of the Function Pack
· Choose the No button.



Invalid function pack
The Function Pack you have attempted to install is corrupt or is a later version. Be sure the file is a valid 
Lucid 3-D Function Pack by re-installing from diskette.    If this doesn't work, you may need a more recent 
version of Lucid 3-D.



Function pack already installed
You have attempted to install a Function Pack that is already installed. There is no need to reinstall this 
Function Pack. To install a more recent version, first remove the function pack and then install the new 
one.



Could not install function pack
Lucid 3-D can't install the requested Function Pack. Make sure the Function Pack is a valid Lucid 3-D 
Function Pack and try again.



Function pack not found
The function pack that was installed is now missing or has become corrupt. You should re-install the pack 
from diskette.



Range transpose failed
The requested Range Transpose failed. 



Invalid tab name
The tab name you entered is not a valid tab name. Make sure you haven't already named another tab 
with the same name.



3-D Links
Use the 3-D Links dialog box to select a file from the list of possible choices.

Dialog Box Options
Links Select the file to open.

Goto Choose Goto to open the currently select file.



Assign Macro
You have requested that a macro be assigned to a push button. 

To assign the macro to the push button
· Choose the Yes button.

To cancel the assignment of the macro to the push button
· Choose the No button.



Unable to print to file
You have attempted to print to a file. Lucid 3-D can't print to this file. Check the file and path name to 
make sure it is a valid location. Also, the disk you have requested may not have enough free space. 



Range too large to graph
The range you have selected is too large to graph. Select a range with a smaller quantity of cells.



Cell editor not available
There are no sheets open at this time. To insert a function into a sheet, first open the desired sheet and 
retry the operation.



Remove pack - Are you sure?
You have attempted to remove a Connectivity Pack. 

To remove the Connectivity Pack
· Choose the Yes button.

To cancel the removal
· Choose the No button.



Remove pack - Are you sure?
You have attempted to remove an installed Connectivity Pack.

To remove the Connectivity Pack
· Choose the Yes button.

To cancel the removal
· Choose the No button.



Abort transfer - Are you sure?
This will cancel the transfer of your file.

To abort the transfer
· Choose the Yes button.

To resume the transfer
· Choose the No button.



File possibly corrupt in the SF Unit
Even though the transfer has been canceled, the SF Unit may have saved your file as though it was 
complete. If so, you should immediately delete this file from the SF Unit. DO NOT attempt to open this file,
as this may corrupt all your data in the SF Unit. It will be necessary to try the transfer again.



Unable to complete transfer
Lucid 3-D was not able to complete the transfer of files. Check all connections and try the transfer again.



Couldn't find (string)
Lucid 3-D for Windows couldn't find the string using the Find command (Edit menu).



Replace x instances
Lucid presents this dialog box to inform you how many instances of the find string it found and replaced 
with the replace string using the Replace command (Edit menu).



Unable to paste data from clipboard
An attempt to paste information from the Clipboard has failed. Copy the information and try pasting again.



Exception error
Lucid 3-D for Windows encountered a error it can't recover from. This could be the result of insufficient 
memory. Try closing other applications and retry the operation. To report this problem please call Lucid 
Product Support at (214) 994-8101.



Value not in valid range
The value in this field you have entered is not in the range of acceptable values. Re-enter the value.



Not a valid number
The value in this field must be a numeric type. Be sure you have entered a valid numeric type.



Field is required
This field requires a value to be entered. You must not leave it unchanged.



Not a valid date
This field requires a valid date. Be sure you have entered a valid date.



Not a valid time
This field requires a valid time. Be sure you have entered a valid time.



Blanks are not allowed
This field can not be left blank. Enter a value before proceeding.



Partial entries are not allowed
This field is incomplete. Be sure you have entered the value completely.




